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การเปลีย่นข้อมูลให้เป็นสารสนเทศ 

ในเชิงธุรกจิ ด้วยโปรแกรมสําเร็จรูป 
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วัตถุประสงคการเรียนรู    

1. เขาใจในวิธีการสรางฟงกชันสําหรับวิเคราะหขอมูล 

1.1 วิธีการสรางสูตรคํานวณ และฟงกชัน 

1.2 ฟงกชั่นเก่ียวกับเง่ือนไขในการตัดสินใจ 

1.3 ฟงกชันเก่ียวกับ Database Lookup and Reference 

2. สามารถนําเสนอขอมูลใหอยูในรูปแบบสารสนเทศเบื้องตนได  

2.1 นําเสนอดวยกราฟ (Chart) 

2.2 นําเสนอดวยการจัดรูปแบบตามเง่ือนไข (Conditional formatting) 

3. สามารถเขาใจการวิเคราะหขอมูลและการจัดระเบียบขอมูล (Analyzing and Organizing Data) 

3.1 หลักการเก็บขอมูล เพ่ือใช Excel เปนฐานขอมูล 

3.2 การกรองขอมูล 

3.3 การเรียงขอมูล 

3.4 การหาผลรวมสรุปยอยของขอมูล  

3.5 การตั้งกฎเพ่ือตรวจสอบขอมูลกอนกรอกลงฐานขอมูล 

3.6 การลบขอมูลท่ีซํ้ากันในฐานขอมูล 

3.7 การแปลงชุดขอความใหเปนตารางขอมูล 

3.8 การนําฐานขอมูลอ่ืน ๆ มาใชใน Excel 

3.9 การใชเครื่องมือ Pivot table เพ่ือการวิเคราะหขอมูล 

4. การสราง Dashboard  

4.1 การกําหนดขอมูลพ้ืนฐาน  

4.2 การกําหนดรูปแบบสี  

4.3 การทําสรุปยอดขายรายป Pivot Table แสดงอัตราการเติบโตเปน %  

4.4 การแสดงขอมูลตาม CATEGORY (ทํา CONTRIBUTION ตามยอดขาย)  

4.5 การแสดง SALE TREND BY CATEGORY  

4.6 การทํากราฟ TOP 10 ของ CUSTOMER  

4.7 COST & PROFIT  

4.8 การทํา SLICER  
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 1. การสร้างสูตรคาํนวณและฟังก์ชัน  

(Applying Formulas and Functions) 

Excel ไดรับการเรียกวาเปนโปรแกรมฐานขอมูลของโลกท่ีนิยมมากท่ีสุดเพราะคุณสามารถ 

จัดเก็บขอมูลจํานวนมหาศาลภายในสมุดงานเดียวหรือแผนงานเดียวได  แตวัตถุประสงคหลักท่ี Excel 

ถูกสรางข้ึน คือการคํานวณ และการใชฟงกชั่นท่ี Excel ไดสรางข้ึนและเตรียมไวใหใชอยางหลากหลาย 

ผูใชสามารถสรางสูตรคํานวณท่ีมีข้ันตอนดําเนินการท่ีซับซอนมากดวยการใชสูตรคํานวณของ Excel 

2010 ท่ีสามารถจัดการกระบวนการของการสรางสูตรท่ีซับซอนไดอยางงายดาย หัวขอนี้จะกลาวถึง

การศึกษาวิธีการสรางสูตรพ้ืนฐานการควบคุม ลําดับการคํานวณภายในสูตร  การเลือกใชขอมูลตาม

ความตองการพ้ืนฐานของสูตร  และการอางชื่อเซลลแบบเฉพาะเจาะจง  

1.1 การสรางสูตรคํานวณและฟงกชัน 

สูตรคํานวณใน Excel มักจะเรียกรวมกันวา Formula แตสามารถแบงออกตามลักษณะของ

การสรางสูตรคํานวณไดเปน 2 ประเภทใหญ ๆ คือ Formula และ Function 

Formula สูตรคํานวณ 

เปนสูตรคํานวณท่ีใชหาผลลัพธโดยท่ีผูใชงาน (User) สรางข้ึนเอง  ซ่ึงประกอบไปดวยสวน

สําคัญ 2 สวนคือ Operand กับ Operator   

1) Operand ตัวถูกดําเนินการ คือขอมูลท่ีถูกนํามาคํานวณ ใหไดเปนผลลัพธออกมา 

ขอมูลท่ีถูกคํานวณเหลานี้อาจเปนไดหลายอยาง เชน ขอมูลตัวเลข ขอมูลท่ีเปน

ขอความหรือตัวหนังสือ ชื่อเซลลท่ีใชสําหรับบรรจุขอมูลก็นํามาใชเปน Operand 

ได แมแตฟงกชันของ Excel เอง ก็สามารถนํามาใชเปน Operand ไดเชนกัน 

2) Operator ตัวดําเนินการ คือเครื่องหมายท่ีใชกํากับการคํานวณ วาตองการใหนํา

ขอมูลมาคํานวณอยางไร ซ่ึงตัวดําเนินการนี้สามารถแบงไดเปน 3 กลุมยอยดังนี้ 

ตารางท่ี 3-1 ตารางเครื่องหมายท่ีใชเปน Operator 

กลุมเคร่ืองหมาย เคร่ืองหมาย 

ตัวดําเนินการทางคณิตศาสตร + - * / % ^ 

Arithmetic Operator บวก ลบ คูณ หาร เปอรเซ็นต ยกกําลัง 

ตัวดําเนินการเปรียบเทยีบ = < > < <= > >= 

Comparison Operator เทากับ ไมเทากับ นอยกวา นอยกวาหรือเทากับ มากกวา มากกวาหรือเทากับ 

ตัวดําเนินการกับขอความ & 

Test Operator And หรือ แอน (นําขอมูลมาวางเรียงตอกัน) 
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กฎในการสราง Formula หรือสูตรคํานวณมีดังนี้ 

1) เวลาพิมพสูตรคํานวณลงในเซลล จะตองข้ึนตนดวยเครื่องหมาย = (เทากับ) เสมอ 

เพ่ือให Excel สามารถแยกความแตกตางไดวาเปนสูตรคํานวณ ไมใชขอความ หรือ

ตัวเลขธรรมดา เชน ถาพิมพวา 2*3 เฉย ๆ ก็จะกลายเปนขอความ “2*3” ไป ไมใชสูตร

ท่ีนํา 2 มาคูณกับ 3 นอกจากเครื่องหมาย = แลว อาจใชเครื่องหมาย + หรือ – นําหนา

สูตรก็ได แลวแตกรณี 

2) สามารถใชเครื่องหมายวงเล็บเปดและปด () เพ่ือบังคับลําดับการคํานวณไดตามตองการ 

ท้ังนี้เพราะ operator แตละตัวจะมีระดับความสําคัญไมเทากัน ซ่ึงหากไมระบุอะไร 

Excel จะดําเนินการคํานวณไปตามลําดับนั้น แตหากใส () ครอมไว โปรแกรมจะ

คํานวณสูตรในวงเล็บกอนเสมอ และถามีวงเล็บหลายชั้น ก็จะคํานวณจากชั้นในสุด

ออกมาตามลําดับ 

3) ระหวาง Operand และ Operator จะพิมพติดกันหรือมีชองวางค่ันก็ได Excel จะไม

สนใจ แตในสูตรท่ีคอนขางซับซอน ควรใสชองวางเพ่ือแบงสูตรออกเปนสวนยอย ๆ 

ตามความจําเปน เพ่ือท่ีจะไดอานไดงายข้ึน 

4) ขอความท่ีจะใชเปน Operand ในสูตร จะตองอยูในเครื่องหมายคําพูด “ “ เสมอ 

มิฉะนั้น Excel จะเขาใจวาเปนชื่อเซลล 

5) Operand ท่ีเปนตัวเลข ใหพิมพเขาไปเฉย ๆ โดยไมตองใสรูปแบบ เชน 1500 จึงจะ

ถูกตอง สวนจุดทศนิยมกับเครื่องหมายลบ สามารถใชไดตามปกติ 

6) ชื่อเซลลท่ีจะใชในสูตร จะตองเปนชื่อเดิมท่ีถูกตอง ตามรูปแบบ หรือเปนชื่อท่ีตั้งไวแลว 

สวนชื่อฟงกชันนอกจากจะตองใชใหถูกตอง และอารกิวเมนต (ท่ีอยูในวงเล็บทาย

ฟงกชัน) ก็จะตองเปนไปตามรูปแบบของแตละฟงกชันดวย มิฉะนั้น Excel จะแสดง

ขอความบอกขอผิดพลาดออกมา 

Function ฟงกชัน 

เปนสูตรคํานวณสําเร็จรูปท่ี Excel เตรียมไวใหผูใชงาน (User) สามารถหาผลลัพธตามท่ี

ตองการไดสะดวกข้ึน Function จะมีรูปแบบท่ีแนนอน Excel สรางไวใหผูใชงานนําไปใชในการ

คํานวณสูตรท่ีมีความซับซอนไดทันทีโดยไมตองสรางสูตรข้ึนมาใหมอีก  เนื่องจากการคํานวณผลลัพธ

หลายอยางมีข้ันตอนท่ีแนนอน หรือทราบอยูแลววาตองใชขอมูลอะไรบาง ดังนั้นผูพัฒนาโปรแกรม 

excel จึงไดสรางสูตรเหลานี้ไวเพ่ือเปนการอํานวยความสะดวกใหกับผูใชงาน รูปแบบการเขียน

ฟงกชันมีดังนี้ 

 

 

 

 

=ช่ือฟังกช์นั (อารกิ์วเมนตท่ี์1, อารกิ์วเมนตท่ี์ 2,อารกิ์วเมนตท่ี์ 3,…) 
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กฎในการสราง Function หรือฟงกชันมีดังนี้ 

1) ถาใชฟงกชันเปนสวนประกอบแรกของสูตร หรือในสูตรนั้นมีแตฟงกชันเพียงอยาง

เดียว ก็จะตองใสเครื่องหมาย = ไวขางหนาฟงกชันเหมือนกับสูตรคํานวณท่ัว ๆ ไป 

2) ช่ือฟงกชัน เปนสวนท่ีใชบอกวาตองการคํานวณหาคาอะไร ซ่ึงตองใชใหถูกตอง

ตามท่ี Excel กําหนดไวเทานั้น หากพิมพชื่อฟงกชันผิด โปรแกรมจะแสดงขอความ

บอกความผิดพลาดออกมาในเซลล 

3) ตอจากชื่อฟงกชันจะตองเปนเครื่องหมายวงเล็บเปด “(“ โดยไมตองเวนวรรค  

ภายในวงเล็บจะเปนอารกิวเมนต และสุดทายตองปดทายดวยเครื่องหมายวงเล็บปด 

“)” เสมอ 

4) อารกิวเมนต (Argument) คือขอมูลท่ีตองสงไปใหฟงกชันเพ่ือใชสําหรับคํานวณหา

ผลลัพธออกมา แตละฟงกชันจะตองการจํานวนอารกิวเมนตไมเทากัน อาจเปนตัว

เดียว หลายตัว หรือบางฟงกชันไมตองการอารกิวเมนตเลย หากฟงกชันใดตองการ

อารกิวเมนตหลายตัว จะตองค่ันระหวางอารกิวเมนตแตละตัวดวยเครื่องหมาย

จุลภาค , 

5) อารกิวเมนตอาจเปนขอมูลไดหลายประเภท เชน ตัวเลข ขอความ วันท่ี –  เวลา 

หรือชื่อเซลล แตก็ข้ึนอยูกับฟงกชันดวย เพราะฟงกชันแตละตัวจะรับเฉพาะ

อารกิวเมนตชนิดท่ีมันตองการ มิฉะนั้นก็จะเกิดขอความแสดงความผิดพลาด เชน 

บางฟงกชัน ตองการเฉพาะขอมูลตัวเลข หรือบางฟงกชันตองการอารกิวเมนตตัว

แรกเปนขอความและตัวท่ีสองเปนตัวเลข เปนตน การจะทราบวาฟงกชันหรือ

สอบถามจาก Office Assistant 

6) อาจใสขอมูลลงไปเปนอารกิวเมนตโดยตรง เชน =SUM(5,7,12) หรือจะใสเปนชื่อ

เซลลท่ีเก็บขอมูลดังกลาว เชน =SUM (A3,B5,E10:E18) หรือแมแตใชฟงกชันหรือ

สูตรเปนอารกิวเมนตก็ได เพียงแตมีขอแมวาสูตรนั้นจะตองใหผลลัพธเปนขอมูล

ชนิดท่ีถูกตอง เชน =SUM(B4/15,E3,42) หรือ =SUM(AVERAGE(E10:E25),A2,B7) 

เปนตน 

7) วิธีใสอารกิวเมนตท่ีเปนขอความ วันท่ี หรือเวลา จะตองใสไวระหวางเครื่องหมาย“” 

เสมอ เชน =LEFT(“สวัสดีครับ”,6) หรือ =DATEVALUE(“22/8/97”)  สวน

อารกิวเมนตท่ีเปนตัวเลข ใหใสเขาไปตรง ๆ โดยไมจัดรูปแบบ เชน 2300 ไมใช 

2,300 

ฟงกชันท่ีนิยมใชมากท่ีสุดใน Excel เปนฟงกชันท่ีใชสําหรับหาผลรวมของคาในชุดของเซลล 

แทนท่ีจะคอย ๆ บวกทีละเซลล ก็เปนนําคาของทุกเซลลท่ีอยูในชวงท่ีตองการมาบวกรวมกันอัตโนมัติ

ซ่ึงจะใชฟงกชัน SUM ตารางตอไปนี้จะอธิบายถึงฟงกชั่นขอมูลอ่ืน ๆ ท่ีชวยสรุปขอมูลจากชุดของ

เซลล ซ่ึงเปนฟงกชันท่ีมีลักษณะเดียวกันกับฟงกชัน SUM 
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ตารางท่ี 3-2 ตารางแสดงรายช่ือฟงกชันท่ีมีลักษณะการคํานวณแบบเดียวกัน 

ฟงกชัน คําอธิบายรายละเอียด อารกิวเมนต 

SUM() หาผลรวมของกลุมตัวเลข ใสไดตั้งแต 1–255 อารกิวเมนต 

COUNT() นับจํานวนเซลลท่ีมีขอมูลตัวเลขในกลุมเซลลท่ีเลือก ใสไดตั้งแต 1–255 อารกิวเมนต 

COUNTA() นับจํานวนเซลลท่ีมีขอมูลในกลุมเซลลท่ีเลือก ใสไดตั้งแต 1–255 อารกิวเมนต 

AVERAGE() หาคาเฉลี่ยมาตรฐานของกลุมขอมูลตัวเลข ใสไดตั้งแต 1–255 อารกิวเมนต 

MIN() หาคาต่ําสุดจากกลุมขอมูลตัวเลข ใสไดตัง้แต 1–255 อารกิวเมนต 

MAX() หาคาสูงสุดจากกลุมขอมูลตัวเลข ใสไดตั้งแต 1–255 อารกิวเมนต 

 

ฟงกชันในตารางท่ี 3-2 จะสามารถระบุอารกิวเมนตไดหลายลักษณะ เชน ระบุเปนตัวเลข ท่ี

ปอนเขาไปในฟงกชันโดยตรง หรือจะเปนตัวเลขท่ีอยูในเครื่องหมายอัญประกาศก็ได หรือจะเปนการ

อางอิงชื่อเซลลเซลลเดียว  หรือการอางอิงชื่อเซลลเปนกลุมเซลลหลาย ๆ เซลลก็ได  แตการอางถึง

กลุมเซลลท่ีมีขอความ หรือชองวาง บรรจุอยูในบางเซลล จะไมสามารถนํามารวมคํานวณได เซลลนั้น

จะถูกละเวนไป  ยกเวนฟงกชัน COUNTA () จะใชนับเซลลไดทุกเซลลท่ีมีขอมูลอยู ไมวาจะมีขอมูล

เปนตัวเลขหรือตัวอักษรก็จะนับหมด ใชสําหรับนับเซลลท่ีไมวาง หรือนับทุกเซลลท่ีมีขอมูลอยูนั่นเอง 

ใสฟงกชันดวยการพิมพลงไปเอง 

ใหทดลองสราง Worksheet ข้ึนมา 1 ชีต โดยมีรายละเอียด ดังรูปท่ี 3-1 แลวดําเนินการตาม

ข้ันตอนตอไปนี้ 

1) คลิกเลือกเซลลปลายทางท่ีตองการใหแสดงผลลัพธ จากตัวอยางเลือกเซลล B8  

2) พิมพเครื่องหมาย = แลวตามดวยชื่อฟงกชัน ขณะพิมพชื่อจะปรากฏรายชื่อฟงกชัน

ข้ึนมาใหดูประกอบไปดวยวามีฟงกชันอะไรบางท่ีข้ึนตนดวยอักษรท่ีพิมพไป ซ่ึง

สามารถนําเมาสคลิกเลือกชื่อไดเลย ไมตองพิมพตอจนจบก็ได  ในท่ีนี้เปนการหา

ผลรวม พิมพชื่อฟงกชัน SUM ลงไป 

3) จะปรากฏคําอธิบายวาฟงกชันดังกลาวใชหาผลลัพธอะไร 

4) พิมพเครื่องหมายวงเล็บเปด  จะปรากฏวิธีการใสอารกิวเมนต ไวเปนตัวชวยดานลาง 

5) ใสอารกิวเมนตตามตองการ ในท่ีนี้ใสกลุมเซลล ตั้งแต B4:B7 

6) พิมพวงเล็บปด แลวกดปุม Enterจะไดผลลัพธท่ีเซลล B8 และดูสูตรไดท่ี Formula bar 
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รูปท่ี 3.1 ข้ันตอนการใสฟงกชันดวยการพิมพลงไปเอง 

3 

4 

5 

2 
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ใสฟงกชันดวยการเรียกปุมคําส่ังจาก Ribbon 

มีข้ันตอนดังนี้ 

1) เลือกเซลลดานลางหรือดานขวาของคาท่ีคุณตองการหาผลรวม  

2) บนแท็บ Home ในกลุมคําสั่ง Editing ใหคลิกท่ีปุม AutoSum  

หรือ บนแท็บสูตรในกลุมไลบรารีฟงกชันคลิกท่ีปุม AutoSum 

 

 

 

 

 

 

3) ตรวจสอบวาชวงของเซลลท่ีแสดงในสูตรนั้นถูกตองแลวกด Enter หรือคลิก

เครื่องหมาย ท่ี Formula bar 

 

 

 

 

 

 

รูปท่ี 3.2  วิธีการใสฟงกชั่นจาก Ribbon 

ใสฟงกชันดวย ปุม Insert Function 

มีข้ันตอนดังนี้  

1) เลือกเซลลท่ีคุณตองการวางผลรวม  

2) คลิกท่ีปุม Insert Function ท่ีอยูบน Formula bar   

หรือบนแท็บ Formulas ในกลุมคําสั่ง Function Library คลิก Math & Trig ปุม, 

จากนั้นในรายการใหคลิก SUM  

 

3) ใน Dialog Box ชื่อ Function 

Argument  ใหใสชวงของเซลลท่ี

ตองการนําตัวเลขมารวมแลวคลิก 

OK 

 

 

 

3 
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รูปท่ี 3.3 วิธีการใสฟงกชั่นจากปุม Insert Function 

วิธีใสฟงกชัน Count เพ่ือนับเซลลท่ีมีคาตัวเลข  

1) เลือกเซลลดานลางหรือดานขวาของชวงท่ีอยูในกลุมเซลลท่ีตองการนับจํานวนเซลล

ท่ีมีคาตัวเลข  

2) บนแท็บ Formula ในกลุม Function Library  คลิกลูกศรท่ีปุม AutoSum แลวให

คลิกฟงกชัน COUNT  จากในรายการ 

3) ตรวจสอบวาชวงของเซลลท่ีแสดงในสูตรนั้นถูกตองแลวกด Enter  

หรือ  

1) เลือกเซลลท่ีคุณตองการวางการนับ  

2) บนแท็บ Formula ในกลุม Function Library  คลิกเลือกคําสั่ง More Function  

แลวเลื่อนลูกศรไปท่ี Statistic และจากนั้นคลิกเลือกฟงกชัน COUNT จากรายการ

ฟงกชัน 

3) ในกลองโตตอบ Function Argument ใสชวงของกลุมเซลลท่ีตองการนับเฉพาะ

เซลลท่ีมีตัวเลขอยู  จากนั้นคลิก OK 

วิธีใสฟงกชัน COUNTA เพ่ือนับทุกเซลลท่ีมีขอมูลทุกชนิด 

1) เลือกเซลลท่ีตองการวางผลการนับ  

2) บนแท็บ Formula ในกลุม Function Library  คลิกเลือกคําสั่ง More Function  

แลวเลื่อนลูกศรไปท่ี Statistic และจากนั้นคลิกเลือกฟงกชัน COUNTA จากรายการ

ฟงกชัน  

3) ในกลองโตตอบ Function Argument ใสชวงของกลุมเซลลท่ีตองการนับ โดยจะ

นับทุกเซลลท่ีมีขอมูลอยู  จากนั้นคลิก OK 

 

3 
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วิธีใสฟงกชัน Average เพ่ือหาคาเฉล่ียในชวงขอมูล  

1) เลือกเซลลดานลางหรือดานขวาของชวงท่ีอยูในกลุมเซลลท่ีตองการหาคาเฉลี่ย  

2) บนแท็บ Formula ในกลุม Function Library  คลิกลูกศรท่ีปุม AutoSum แลวให

คลิกฟงกชัน  Average จากรายการ 

3) ตรวจสอบวาชวงของเซลลท่ีแสดงในสูตรนั้นถูกตองแลวกด Enter  

หรือ  

1) เลือกเซลลท่ีคุณตองการวางคาเฉลี่ย  

2) บนแท็บ Formula ในกลุม Function Library  คลิกเลือกคําสั่ง More Function  

แลวเลื่อนลูกศรไปท่ี Statistic และจากนั้นคลิกเลือกฟงกชัน AVERAGE  จาก

รายการ 

3) ในกลองโตตอบ Function Argument ใสชวงของกลุมเซลลท่ีตองการหาคาเฉลี่ย 

แลวกด OK 

วิธีใสฟงกชัน MIN เพ่ือหาคาต่ําสุดในชวงขอมูล  

1) เลือกเซลลดานลางหรือดานขวาของชวงท่ีอยูในกลุมเซลลท่ีตองการประเมิน  

2) บนแท็บ Formula ในกลุม Function Library  คลิกลูกศรท่ีปุม AutoSum แลวให

คลิกฟงกชัน  MIN  จากรายการ 

3) ตรวจสอบวาชวงของเซลลท่ีแสดงในสูตรนั้นถูกตองแลวกด Enter  

หรือ  

1) เลือกเซลลท่ีคุณตองการวางคาต่ําสุด 

2) บนแท็บ Formula ในกลุม Function Library  คลิกเลือกคําสั่ง More Function  

แลวเลื่อนลูกศรไปท่ี Statistic  และจากนั้นในรายการใหคลิก MIN  

3) ในกลองโตตอบ Function Argument ใสชวงของเซลลท่ีตองการจะประเมินผล 

แลวกด  OK 

วิธีใสฟงกชัน MAX เพ่ือหาคาท่ีสูงท่ีสุดในชวงขอมูล  

1) เลือกเซลลดานลางหรือดานขวาของชวงท่ีอยูในกลุมเซลลท่ีตองการประเมิน  

2) บนแท็บ Formula ในกลุม Function Library  คลิกลูกศรท่ีปุม AutoSum แลวให

คลิกฟงกชัน  MAX  จากรายการ 

3) ตรวจสอบวาชวงของเซลลท่ีแสดงในสูตรนั้นถูกตองแลวกด Enter  

หรือ  

1) เลือกเซลลท่ีคุณตองการวางคาสูงสุด  

2) บนแท็บ Formula ในกลุม Function Library  คลิกเลือกคําสั่ง More Function  

แลวเลื่อนลูกศรไปท่ี Statistic  และจากนั้นในรายการใหคลิก  MAX  

3) ในกลองโตตอบ Function Argument ใสชวงของเซลลท่ีตองการจะประเมินผล 

แลวกด  OK 
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Enforce Precedence การบังคับลําดับในการคํานวณ 

Operator แตละตัวมีความสําคัญท่ีไมเทาเทียมกัน ดังนั้น เวลาใชงานโดยเฉพาะในสูตรท่ี

ซับซอน และยาว ๆ จะตองใชความระมัดระวังเปนอยางมากเพราะถาลําดับการคํานวณผิด ก็จะได

ผลลัพธออกมาไมตรงกับท่ี Excel คํานวณให ดังนั้น จึงใชเครื่องหมายวงเล็บ ( ) ครอมสวนท่ีตองการ

ใหคํานวณกอนเอาไวก็จะชวยขจัดความผิดพลาดได  

ยกตัวอยางเชน เม่ือใสสูตร =2+3*5  โดยตองการใหโปรแกรมนํา 2 กับ 3 มาบวกกันกอน 

(ซ่ึงจะได 5) แลวจึงนําไปคูณกับ 5 ซ่ึงจะไดผลลัพธเปน 25แตเนื่องจากเครื่องหมายคูณ * มีระดับ

ความสําคัญสูงกวาเครื่องหมายบวก + ดังนั้น ในความเปนจริง Excel จะนําไปคูณกับ 5 กอน (ได 15) 

แลวจึงบวกกับ 2 ซ่ึงจะไดผลลัพธเปน 17 จะเห็นไดวาคําตอบแรกผิดพลาดเพราะ Excel คิดไมเหมือน

ท่ัว ๆ ไป วิธีท่ีจะบังคับให Excel คํานวณใหไดผลลัพธตามท่ีตองการคือใสเครื่องหมาย ( ) ครอมสวน

ท่ีตองการใหคํานวณกอน เปน=(2+3)*5 เทานี้คําตอบท่ีไดก็จะถูกตองอยางแนนอน 

ตารางตอไปนี้จะแสดงระดับความสําคัญของ Operator จากมากไปนอย Operator ท่ีมีระดับ

ความสําคัญสูงจะถูกคํานวณกอน Operator ท่ีมีระดับความสําคัญต่ํากวาและถามี Operator ท่ีมีระดับ

ความสําคัญเดียวกันในสูตร Excel จะคํานวณจากซายไปขวาทีละตัว 

 

ตารางที่ 3-3 ตารางแสดงลําดบัในการคํานวณของ Operator 

ระดับ Operator คําอธิบาย 

1 Reference 

Operators 

เค ร่ืองหมายอางอิง ไดแกสัญลักษณ  The colon ( : )  , Space (  ) , and 

comma (,) 

2 - คือเคร่ืองหมายที่แสดงคาลบของตัวเลขเชน –1 

3 % เปอรเซ็นต (นําตัวเลขหนาเคร่ืองหมาย % ไปหารดวย 100) 

4 ^ ยกกําลัง (นําตัวเลขหนาเคร่ืองหมาย ^ คูณตัวเองตามจํานวนคร้ังที่เปนตัวเลขที่

อยูหลังเคร่ืองหมาย ^ ) 

5 * และ / คูณ และ หาร (ระดับเดียวกัน ทําไลจากซายไปขวา) 

6 + และ - บวก และ ลบ (ระดับเดียวกัน ทําไลจากซายไปขวา) 

7 & นําขอความตั้งแต 2 ขอความข้ึนไปมาตอกันเปนขอความเดียวกัน 

8 =  <><=  >= 

<> 

ตัวดําเนินการเปรียบเทยีบ  

 

Apply Cell References In Formulas  

สูตรในแผนงาน Excel สวนใหญมักจะเก่ียวของกับฟงกชั่น การดําเนินการเก่ียวกับคา ท่ีมีอยู

ในหนึ่งหรือหลายเซลลบนแผนงานเดียวกัน หรือบนแผนงานอ่ืน การอางอิง ท่ีคุณทําในสูตรกับเนื้อหา

ของเซลลบนแผนงานเปนท้ังแบบสัมพัทธ และอางอิงแบบสัมบูรณหรืออางอิงผสมกัน 
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Cell Reference in Formulas การอางช่ือเซลลในสูตรคํานวณ 

Excel มีวิธีอางถึงชื่อเดิมของเซลลหรือ Cell Reference อยู 3 แบบ คือ แบบสัมพัทธ 

(Relative Reference) แบบสัมบูรณ (Absolute Reference) ซ่ึงท้ังคูนี้ใหผลท่ีแตกตางกัน และแบบ

ผสม   ดังนั้นจึงเปนเรื่องจําเปนท่ีจะตองเรียนรูและทําความเขาใจอยางถูกตอง เพ่ือสามารถเลือกใชได

อยางถูกตองวาเม่ือใดท่ีควรจะอางอิงแบบ Relative หรือ Absolute หรือใชท้ังสองแบบผสมกัน 

1) การอางชื่อเซลลแบบสัมพันธ (Relative) 

เปนชื่อท่ีหมายถึงเซลลหนึ่งเซลลใด (หรือกลุมเซลลหนึ่งกลุมใด) โดยอางอิงแบบสัมพัทธใน

เชิงตําแหนงกับเซลลท่ีอางถึงมัน  

 

ตารางท่ี 3-4 ตารางแสดงความหมายของการอางช่ือเซลลแบบ Relative Reference 

ช่ือ

เซลล 

เม่ืออางจาก

เซลล 
จะมีความหมายวา 

B3 C3 เปนเซลลท่ีอยูถัดไปทางซาย 1 คอลัมน 

B3 F2 เปนเซลลท่ีอยูถัดไปทางซาย 4 คอลัมนและถัดลงไปขางลาง 1 แถว 

F2:F8 F9 เปนกลุมเซลล 7 เซลลท่ีอยูถัดข้ึนไปขางบนในคอลัมนเดียวกัน 

A4:D4 F4 เปนกลุมเซลล 4 เซลลท่ีอยูถัดไปทางซาย 1 คอลัมนแตอยูภายในแถว

เดียวกัน 

 

ดังนั้นการอางชื่อเซลลแบบนี้จะสามารถเปลี่ยนแปลงไดตลอดเวลา ข้ึนอยูกับวาเซลลท่ีอางถึง

มันนั้น ถูกยายหรือคัดลอกไปยังท่ีใดในเวิรกบุค เชน ถาในเซลล C3 มีสูตรวา =B3+5 เม่ือยายสูตรนี้

ไปยังเซลล C7 สูตรนี้จะถูกเปลี่ยนเปน =B7+5 โดยอัตโนมัติ 

การอางอิงชื่อเซลลแบบนี้แมจะมีวิธีคิดท่ียุงยากแตก็มีประโยชนมากกวาแบบ absolute ซ่ึง

ประโยชนท่ีเห็นไดชัดคือชวยใหสามารถคัดลอกสูตรท่ีใชคํานวณขอมูลในแนวแถวหรือแนวคอลัมน 

จากเซลลหนึ่งไปยังอีกเซลลหนึ่งหรือหลายเซลลก็ได ทําใหไมตองพิมพสูตรลักษณะเดียวกันซํ้า ๆ 

หลายครั้ง  

2) การอางชื่อเซลลแบบสัมบูรณ (Absolute) 

เปนการอางอิงชื่อเซลล ท่ีหมายถึงเซลลหนึ่ ง เซลลใด (หรือกลุมหนึ่ งกลุมใด) อยาง

เฉพาะเจาะจง คือระบุไดแนนอนเลยวาหมายถึงเซลลนั้น ๆ โดยไมสนใจวากําลังอางถึงจากตําแหนง

ไหน ขอสังเกตของชื่อประเภทนี้คือ จะมีเครื่องหมาย $ อยูขางหนาชื่อคอลัมน และชื่อแถวเสมอ และ

มักเรียกกันอีกอยางหนึ่งวา “ล็อคเซลล”   

 

 

 



74 บทท่ี 3 การเปลี่ยนขอมูลใหเปนสารสนเทศในเชิงธุรกิจ ดวยโปรแกรมสําเร็จรูป 

 

ตารางท่ี 3-5 ตารางแสดงความหมายของการอางช่ือเซลลแบบ Absolute Reference 

ช่ือเซลล ความหมาย 

$B$3 หมายถึงเซลลB3อยางเฉพาะเจาะจง 

$D:$D หมายถึงเซลลในคอลัมนDอยางเฉพาะเจาะจง 

$F$5:$G$12 หมายถึงกลุมเซลลF5 ถึง G12อยางเฉพาะเจาะจง 

Sheet1!$D$2:$D$4 
หมายถึงกลุมเซลลD2ถึง D4ในเวิรกชีตชื่อ “Sheet1”อยาง

เฉพาะเจาะจง 

 

โดยท่ัวไปจะใชการอางอิงแบบนี้กับขอมูลท่ีเปนคาคงท่ี หรือเปนขอมูลท่ีมีเพียงตัวเดียวใน

เวิรกชีต หรือเวลาท่ีจะตั้งชื่อใหมใหกับเซลลตาง ๆ ไมวาจะยายหรือคัดลอกท่ีอางถึงมันไปยังท่ีอ่ืนใด ๆ 

ในเวิรกชีต   

ชื่อแบบ Absolute มีโอกาสเปลี่ยนแปลงไดเหมือนกันในกรณีท่ีมีการลบแถว หรือคอลัมน

ของเวิรกชีตออก ทําใหตําแหนงของเซลลท่ีถูกอางถึงนั้นเปลี่ยนไป Excel ก็จะตามไปแกไขชื่อแบบ 

Absolute ท่ีใชในสูตรตาง ๆ ใหโดยอัตโนมัติ   

 

 

 

 

 

 

 

 

 

 

 

รูปท่ี 3.4 ตัวอยางการอางชื่อเซลลแบบ Relative และ Absolute 

 

3) การอางชื่อเซลลแบบผสม 

นอกจากการใชชื่อเซลลแบบใดแบบหนึ่งใน 2 แบบขางตนแลว ยังสามารถนําชื่อแบบ  

Relative ผสมกับแบบ absolute ไดดวยเชน $B3, F$5 หรือ $B4:$B9 เปนตน วิธีพิจารณาชื่อแบบ

นี้ใหใชหลักงาย ๆ คือ ถามีเครื่องหมาย $ นําหนาสวนใด ก็จะเปนการล็อคสวนนั้นไวเชน $B3 ก็จะ
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หมายความวา ถามีการคัดลอกสูตรไปเซลลใด ๆ คอลัมน B จะถูกล็อคไว (เปน B เหมือนเดิม) แตแถว

จะเปลี่ยนเองไดอัตโนมัติเปนแถวท่ี 4 5 6 แลวแตสถานการณ  

ประโยชนของชื่อเซลลแบบนี้จะเปนการผสมผสานกันระหวางชื่อแบบ Relative กับ 

Absolute คือ สามารถบังคับใหเกิดการเปลี่ยนแปลงชื่อเซลลในทิศทางท่ีตองการไดมากข้ึน  

รูปแบบการอางช่ือเซลล 

Excel มีวิธีการอางชื่อเซลล ดังนี ้

1) เม่ืออางถึงเซลล เซลล เดียวในเวิรกชีตเดียวกัน ใชรูปแบบ <คอลัมน><แถว>                   

เชน E8 K32 

2) เม่ืออางถึงกลุมเซลลในเวิรกชีตเดียวกันใชรูปแบบ <ชื่อเซลลเริ่มตน>:<ชื่อเซลล

สุดทาย>เชน B4:B36  D7:W7 ความหมายของชื่อเหลานี้ก็คือ เซลลทุก ๆ เซลลท่ี

อยูภายในพ้ืนท่ีสี่เหลี่ยม ซ่ึงมีเซลลเริ่มตนและเซลลสุดทายอยูท่ีมุมตรงกันขาม 

3) เม่ืออางถึงเซลลในเวิรกชีตอ่ืนของเวิรกบุคเดียวกัน  ใชรูปแบบ <ชื่อเวิรกชีต>!<ชื่อ

เซลล>เชน sheet2!A15  sheet5!C7:F12 ‘คาใชจาย 42’!G32 เปนตน สําหรับ

เครื่องหมาย ‘ (appostophy) ท่ีใสเขามานี้ เ พ่ือแกปญหากรณีท่ีชื่อเวิรกชีตมี

ตัวอักษรท่ีสรางความสับสนให Excel เชน ชองวาง หรือเครื่องหมายขีด (-) แตเม่ือ

ใช  ‘  ปดหัวและทายชื่อเวิรกชีตแลว โปรแกรมก็จะทราบวาขอความท้ังหมดท่ีอยู

ภายในก็คือชื่อเวิรกชีต 

4) เม่ืออางถึงเซลลในเวิรกบุคอ่ืน  ใชรูปแบบ [<ชื่อเวิรกบุค>]<ชื่อเวิรกชีต>!<ชื่อเซลล>

เช น  [sale_40 .xlsx] sheet1 !C6 [ทะเบี ยนพนั กงาน .xlsx]ประวั ติ !K2 :K10  

‘[Exchange-  rate.xls]sheet1’!C9:G12 สําหรับเครื่องหมาย ‘  ในชื่อสุดทายนี้ก็ใช

เม่ือชื่อเวิรกบุคหรือเวิรคชีตมีปญหาเชนกัน  แตตองใสใหครอบคลุมชื่อท้ังสองเสมอ 

จากการอางอิงชื่อเซลลตามวิธีดังกลาวขางตน ทําใหผูใชงานประสบปญหาในการนําชื่อเซลล

เหลานี้ไปใช เนื่องจากกวาจะเขาใจวาหมายถึงเซลลใด ก็ตองเขียนกันยืดยาวและจดจํายาก Excel จึง

ยอมใหผูใชงานสามารถสรางชื่อเซลลข้ึนมาใชงานเองใหมได เพ่ืออํานวยความสะดวกใหผูใชและจดจํา

ไดงายข้ึน และหลักการนี้ยังนําไปสูการตั้งตัวแปร หรือกําหนดคาใหกับชื่อ เพ่ือนําคานั้นกลับมาใช

ภายหลังไดสะดวกข้ึน โดยไมจําเปนตองใสคาตาง ๆ ไวภายในเซลลเสมอไป แตอาจกําหนดเปนคา

ตัวเลขใด ๆ ไวภายในชื่อท่ีตั้งข้ึนมาก็ได 

1.2  ฟงกชันเกี่ยวกับเงื่อนไขในการตัดสินใจ 

การสรางสูตรคํานวณและฟงกชันท่ีมีเง่ือนไขในการตัดสินใจ 

ใน Excel 2016 จะมีฟงกชันท่ีสามารถแสดงผลเฉพาะเม่ือเง่ือนไขตรงตามท่ีกําหนดได  

เพ่ือใหผูใชงานสรางสูตรท่ีจะใชตรรกะเง่ือนไขในการตรวจสอบไดโดยใชฟงกชัน IF( )  ซ่ึงรูปแบบของ

ฟงกชัน IF( ) จะเริ่มจากดําเนินการทดสอบตรรกะ แลวสงกลับหนึ่งในสองคาตามท่ีกําหนดไวข้ึนอยูกับ

วาผลการทดสอบตรรกะประเมินเปน TRUE หรือ FALSE   
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ฟงกชัน IF( ) เหมาะสําหรับใชในงานท่ีมีลักษณะตรวจสอบเง่ือนไขหรือมีการพิจารณา

ตัดสินใจเพ่ือท่ีจะเลือกกระทําหรือเลือกดําเนินการอยางใดอยางหนึ่งจากสองทาง (หรือมากกวานั้น

หากใช  IF ซอนกันหลาย ๆ ครั้ง) ถาผลลัพธออกมาเปนจริงจะทําสิ่งหนึ่งถาเปนเท็จจะทําอีกสิ่งหนึ่ง 

ไวยากรณท่ีถูกตองสําหรับฟงกชัน IF() จะเปนดังนี้: 

= IF (logical_test, value_if_true, value_if_false) 

Logical_Test คือคาใด ๆ เง่ือนไขหรือนิพจนใดๆท่ีสามารถคํานวณออกมาไดผล

ลัพธทางตรรกะเปนTrue หรือFalse  

Value_If_True คือคาท่ีจะสงกลับ (หรือผลลัพธท่ีจะมีผลเกิดข้ึน) ถาเง่ือนท่ีใช

ทดสอบนั้นเปนจริง 

Value_IF_False คือคาท่ีจะสงกลับ (หรือผลลัพธท่ีจะมีผลเกิดข้ึน) ถาเง่ือนท่ีใช

ทดสอบนั้นเปนเท็จ 

นอกจากนี้ยังมีฟงกชั่นท่ีมีลักษณะเปนตรรกะเง่ือนไขเชนนี้อีก  ดังท่ีแสดงในตารางตอไปนี้  

ตารางที่ 3-6 ตารางแสดงรายชื่อฟงกชั่นแบบ Conditional Formulas 

ช่ือฟงกชัน คําอธิบายฟงกชัน  

AVERAGEIF ()  สงกลับคาเฉลี่ยของคาในชวงท่ีตรงกับหนึ่งหรือมากกวาเกณฑ  

AVERAGEIFS () 

COUNTIF ()  สงกลับจํานวนของเซลลในชวงท่ีตรงกับหนึ่งหรือมากกวาเกณฑ 

COUNTIFS () 

SUMIF ()  สงกลับผลรวมของคาในชวงท่ีตรงกับหนึ่งหรือมากกวาเกณฑ 

SUMIFS () 

IFERROR () คืนหนึ่งคาถาผลลพัธของสูตรในขอผิดพลาด 

แตละฟงกชั่นจะมีวิธีการใสเง่ือนไข ท่ีระบบแจงใหทราบ โดยมีลักษณะเปนคําแนะนําท่ีจะ

ปรากฏเครื่องมือข้ึนมาใหเม่ือผูใชงานเริ่มปอนสูตรเพ่ือใหแนใจวา ผูใชจะสามารถสรางสูตรท่ีถูกตอง

สําหรับแตละฟงกชันไดและสะดวกในการทํางาน 

ฟงกชันซอนฟงกช่ัน (Nesting Functions) 

หมายถึงการใชฟงกชันหนึ่งเปนอารกิวเมนตของอีกฟงกชันหนึ่งซอนกันเขาไปเรื่อย ๆ ซ่ึงไดมี

การปรับปรุงจากเดิม เวอรชั่น 97-2003 ซอนได 7 ชั้น ในเวอรชั่น 2016 นี้ สามารถใชฟงกชันซอนกัน

ไดสูงถึง 64 ชั้น  ท้ังนี้ข้ึนอยูกับความซับซอนของสูตรคํานวณท่ีตองการ วิธีใสฟงกชันซอนฟงกชัน

อาจจะพิมพเขาไปเอง หรือจะคลิกเลือกคําสั่งจากไดอะล็อกบอกซก็ได  ซ่ึงก็ตองระมัดระวังเรื่อง

ตําแหนงอารกิวเมนตและวงเล็บเปด–ปดใหถูกตอง แตถายังไมคอยม่ันใจอาจใชกลองโตตอบจะชวยใส

ใหก็ได ซ่ึงมีขอดีคือ จะมีคําอธิบายคอยบอกกํากับใหตลอด และมีการแยกแยะอารกิวเมนตเปนสวน ๆ 
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ทําใหไมสับสน เม่ือตองการเพ่ิมอารกิวเมนตเขาไป ฟงกชันท่ีนิยมนํามาใชเปน Nested Function คือ 

ฟงกชัน IF ในท่ีนี้จึงขออธิบายตัวอยางการใชงานฟงกชันซอนฟงกชันดวยฟงกชัน IF 

 

 

 

 

 

 

 

 

 

รูปที่ 3.5 ตัวอยางขอมูลสําหรับใสฟงกชันซอนฟงกชัน 

ยกตัวอยางการใสฟงกชัน  จากรูปดานบน เปนรายการขายหนังสือประจาํสัปดาห ถาตองการ

ใสฟงกชันเพ่ือใหมีการคํานวณหาสภาพการขาย โดยมีเง่ือนไขดังนี้ 

- ถายอดขายหนังสือตั้งแต 0 – 10 เลม ใหแสดงคําวา “ยอดขายต่ํา” 

- ถายอดขายหนังสือตั้งแต 11 – 20 เลม ใหแสดงคําวา “ปกติ” 

- ถายอดขายหนังสือตั้งแต 21 เลมข้ึนไป ใหแสดงคําวา “ขายดี” 

จากเง่ือนไขสามารถนํามาเขียนเปนฟงกชัน และมีข้ันตอนการใสฟงกชันดวยกลองโตตอบดังนี้ 

8) คลิกท่ีเซลล G4 แลวกดปุม Insert Function ท่ีอยูตรง Formula bar หรือใน 

Ribbon แท็บ Formula 

9) คลิกเลือกฟงกชัน If แลวกดปุม OK 

10) จะปรากฎกลองโตตอบ Function Arguments ข้ึนมาซ่ึงในท่ีนี้จะเปนของฟงกชัน 

IF สังเกตจากชื่อฟงกชันท่ีมุมซายบน  แลวใสอารกิวเมนตลงไปดังนี้  

- ชอง Logical_Test  ใสเง่ือนไขแรกลงไปวา E4<= 10  ในท่ีนี้หมายถึง นํา

ตัวเลขในชอง E4 มาเปรียบเทียบวามีคานอยกวาหรือเทากับ 10 หรือไม 

- ชอง Value_if_true  ใสคา ถาเง่ือนไขในชองLogical_Test เปนจริง ใหใสลง

ไปวา “ยอดขายต่ํา”  ในท่ีนี้หมายความวา ถาคาใน E4 นอยกวาหรือเทากับ 

10 จริง ใหแสดงคําวา   ยอดขายต่ํา   ออกมา  

- ในชอง  Value_if_false  ใสคา ถาเง่ือนไขในชอง logical_test เปนเท็จ  ซ่ึงตาม

ตัวอยาง ถาตัวเลขไมไดนอยกวา 10 จะมีการเปรียบเทียบตอวา คาในชอง E4 

นอยกวาหรือเทากับ 20 หรือไม  ซ่ึงการเปรียบเทียบดังกลาวจะตองใสฟงกชัน IF 

อีกตัวซอนเขาไป ใหเอาเมาสคลิกชองนี้ไว  แลวดําเนินการตอในขอ 4) 
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รูปที่ 3.6 แสดงวิธีการใสเงื่อนไขในฟงกชัน IF( ) 

11) คลิกเลือกฟงกชัน IF อีกตัวซอนเขาไปโดยคลิกท่ี บริเวณท่ีเคยเปน Name box ดังรูป 

 

 

 

 

 

 

 

รูปที่ 3.7 แสดงวิธีการใสฟงกชนั IF( ) ตัวทีส่อง ซอนในฟงกชนั IF( ) ตัวแรก 

12) Excel จะเรียกกลองโตตอบสําหรับใสฟงกชัน IF อีกตัวข้ึนมาอีกหนึ่งกลองโตตอบ 

ซ่ึงสังเกตวาเปนคนละตัวไดจาก Formula bar  

 

 

 

 

 

 

 

รูปที่ 3.8 แสดงจุดสังเกตในการใสฟงกชัน IF( ) ตัวที่สอง ซอนในฟงกชนั IF( ) ตัวแรก 

13) ใสอารกิวเมนตตาง ๆ ลงไปดังนี้ 

5 
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- ชอง Logical_Test  ใสเง่ือนไขแรกลงไปวา E4<= 20  ในท่ีนี้หมายถึง นําตัวเลขใน

ชอง E4 มาเปรียบเทียบวามีคานอยกวาหรือเทากับ 20 หรือไม 

- ชอง Value_if_true  ใสคา ถาเง่ือนไขในชอง Logical_Test เปนจริง ใหใสลงไปวา 

“ปกต”ิ  ในท่ีนี้หมายความวา ถาคาใน E4 นอยกวาหรือเทากับ 20 จริง ใหแสดงคํา

วา   ปกต ิ  ออกมา  

- ในชอง  Value_if_false  ใสคา ถาเง่ือนไขในชอง logical_test เปนเท็จ  ใหใสลงไป

วา “ขายดี”  ในท่ีนี้หมายความวา ถาคาใน E4 ไมไดนอยกวาหรือเทากับ 20 (หรือ

สูงกวา 20  หรือมีคาตั้งแต 21 ข้ึนไปนั่นเอง) ใหแสดงคําวา ขายดี  ออกมา   เสร็จ

แลวกดปุม OK  

 

 

 

 

 

 

 

 

 

 

 

 

รูปที่ 3.9 แสดงการใสเงื่อนไขในฟงกชนั IF( ) ตัวทีส่อง 

จะไดผลลัพธดังในรูปดานลาง ซ่ึงจะเปนการใชฟงกชัน IF ซอนกัน โดยใช IF ตัวท่ี 2 เปน

อารกิวเมนตในสวนของ Value_if_False ของฟงกชัน If ตัวท่ี 1 

 

 

 

 

 

รูปที่ 3.10 แสดงการหาผลลัพธ การใชฟงกชัน IF( ) ซอนกันสองตัว 

 

 

1 2 
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ขอสังเกตจากวิธีใสฟงกชันซอนฟงกชันขางตนคือ 

1) สามารถใสฟงกชันซอนกันหลาย ๆ ชั้นไดสูงถึง 64 ชั้น โดยเลือกอีกฟงกชันหนึ่งใส

ลงในชองอารกิวเมนตของฟงกชันชั้นนอกซอนกันเขาไปเรื่อย ๆ และเวลาทําก็ตอง

พิจารณาดูดี ๆ วาขณะนี้กําลังทํางานกับฟงกชันใดอยู โดยดูท่ีมุมซายบนของกลอง

โตตอบ Formula Argument ซ่ึงจะมีชื่อฟงกชันกํากับอยู และดูสูตรคํานวณท่ี 

Formula Bar ซ่ึงชื่อฟงกชันนั้นจะเปนตัวหนากวาปกติ 

2) ถาฟงกชันท่ีจะใชเปนอารกิวเมนตไมมีอยูในรายการท่ีใชบอย ก็ตองพิมพเขาไปเอง 

โดยพิมพชื่อฟงกชันตามดวยวงเล็บเปด แลวเลื่อนเมาสพอยเตอร ไปคลิกท่ีชื่อ

ฟงกชันนี้ในสูตร เพ่ือเปดกลองโตตอบ Formula Argument ข้ึนมา  

3) เม่ือจะยายการทํางานจากฟงกชันหนึ่งไปยังอีกฟงกชันหนึ่งใหเลื่อนเมาสพอยเตอร 

ไปคลิกท่ีชื่อฟงกชันนั้นใน Formula Bar สวนการคลิกปุม OK หรือกดปุม Enter 

จะใชเม่ือตองการจบสูตรท้ังหมดเทานั้น 

ผูใชงานสามารถเพ่ิมเติมฟงกชั่นซอนกันไดอีกเพ่ือให Excel ประเมินหลายเง่ือนไขกอนท่ี

จะใหผลลัพธออกมา  ผูใชสามารถเพ่ิมการทดสอบตรรกะเขาไปในสูตรสวนเง่ือนไขไดอีก โดยใช

ฟงกชันตอไปนี้:  

- ฟงกชัน AND( )  จะคืนคา TRUE เทานั้น หากทุกการทดสอบตรรกะขางในเปนจริง

หมด เชน = IF (AND ป (= 2011 เดือน, = "กรกฎาคม"), B2 * C4, "No") 

- ฟงกชัน OR( ) จะคืนคา TRUE ถามีการทดสอบตรรกะภายในอันใดอันหนึ่งเปนจริง  

- ฟงกชัน NOT( ) จะกลับทิศทางของผลเชิงตรรกะของการทดสอบตรรกะ  
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1.3  ฟงกชันเกี่ยวกับ Database Lookup and Reference 

การใชงานฟงกชัน Lookup and Reference   

เม่ือไดสรางตารางขอมูลเก็บไว แลวตองการเขาไปคนหาขอมูลจากตารางนั้น โดยท่ีไมทราบ

วาขอมูลท่ีตองการมีคาเทาใดกันแน สามารถใชฟงกชัน VLOOKUP() หรือ HLOOKUP() ซ่ึงจะทํางาน

ดวยการคนหาจากคอลัมนซายสุดของตาราง แลวอางไปถึงคาในแถวเดียวกันท่ีอยูคอลัมนถัดไป และ

ยังสามารถกําหนดไดวาตองการคาในคอลัมนใด  

ตารางที่ 3-7 ตารางแสดงรายชื่อฟงกชั่นแบบ Lookup and Reference 

ฟงกชัน รูปแบบการใชงาน ความหมาย 

VLOOKUP VLOOKUP(ขอมลูท่ีใชคนหา, ตารางขอมูล, 

คอลัมนของขอมูลผลลัพธ) 

เปนการใชคาในคอลัมนแรกเปนดัชนีหาขอมลูในตาราง 

HLOOKUP HLOOKUP(ขอมลูท่ีใชคนหา, ตารางขอมูล, 

คอลัมนของขอมูลผลลัพธ) 

เปนการใชคาแถวแรกเปนดัชนีหาขอมูลในตาราง 

Row() ROW(ช่ือเซลล หรือไมใสขอมลูก็ได) ฟงกชันจะคืนคากลับมาเปนตัวเลขของแถว หรือแถวแนวนอน

ของเซลลท่ีอางถึง ถาไมใสช่ือเซลลจะคืนคาแถวท่ีกําลังใชงาน

อยูในขณะน้ัน 

Column() COLUMN(ช่ือเซลล หรือไมใสขอมลูก็ได) ฟงกชันจะคืนคากลับมาเปนตัวเลขของคอลัมน หรือแถว

แนวตั้งของเซลลท่ีอางถึง ถาไมใสช่ือเซลลจะคืนคาแถวท่ีกําลัง

ใชงานอยูในขณะน้ัน 

 

ดูตัวอยางจาก รูปท่ี 3.11 แสดงการหาผลลัพธ การใชฟงกชัน Vlookup  แลวทดลองคนหา

ขอมูลโดยใช VLOOKUP ดังรูป 
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รูปที่ 3.11 แสดงการหาผลลัพธ การใชฟงกชัน VLookup 

จากรูปท่ี 3.10 รูปแรกเปนตารางขอมูลทะเบียนพนักงานของบริษัทสยามการคาจํากัด จาก

รูปดังกลาวตองการหาเงินเดือนของพนักงาน โดยคนจากนามสกุล จึงสรางเปนตารางเล็ก ๆ ไวท่ี เซลล 

I4:J5 โดย นามสกุลท่ีตองการคนเปนเง่ือนไขใสไวในเซลล J4  สวนผลลัพธจะปรากฎในเซลล J5  และ

ในเซลล J5 ใสสูตรไวตามรูปท่ีสองดานลาง  ซ่ึงคําอธิบายการใชงานฟงกชัน VLOOKUP มีดังนี้ 

=VLOOKUP (เง่ือนไขท่ีตองการคนหา, ชวงเซลลท่ีตองการคนหา, ลําดับคอลัมนท่ีตองการให

แสดงผลลัพธ, กําหนดวิธีคน) 

ในการกําหนดวิธีการคน มี 2 แบบคือใสเปนคา True ซ่ึงใชเพ่ือหาการจับคูท่ีใกลเคียงท่ีสุดใน

คอลัมนแรก  False ใชสําหรับคนหาและการจับคูแบบตรงท้ังหมด 

สําหรับฟงกชัน HLOOKUP() ทํางานเหมือนกันกับ VLOOKUP() เพียงแตเปลี่ยนจากลําดับ

การคนจากคอลัมน เปนแถว แทน  หรือสรุปงาย VLOOKUP() คนหาผลลัพธท่ีอยูในคอลัมน  แต 

HLOOKUP() คนหาผลลัพธท่ีอยูในแถว 

ฟงกชั่น ROW() และ COLUMN() ใชในกรณีท่ีตองการให Excel ระบุตําแหนงใหวา เซลลท่ี

เราจะใชงาน หรือเซลลปจจุบันนั้น อยูในคอลัมน หรือแถวท่ีเทาไหร เพ่ือนําไปเปนสวนประกอบหนึ่ง

ในการคํานวณตอ อาทิเชน ตองการ ใสสีพ้ืนใหกับเซลลท่ีอยูในแถวคู (หรือหารดวย 2 ลงตัว) 
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การใชงานฟงกชัน Database   

เม่ือสรางตารางขอมูลเก็บไวเรียบรอยแลว ผูใชสามารถใสสูตรเพ่ือหาคําตอบจากตารางขอมูล

ตามเง่ือนไขไดไมยาก ซ่ึงสูตรเหลานี้จะกลายมาเปนสารสนเทศ หรือรายงานสรุป ท่ีสามารถสรางได

โดยงาย และทําความเขาใจไดไมยาก มีพ้ืนฐานจากฟงกชั่นท่ัวไปท่ีเคยใชตามปรกติ เพียงแตเพ่ิมเติม

ในสวนของการสรางเง่ือนไขเพ่ือให Excel หาผลลัพธใหไดตามท่ีผูใชงานตองการ ฟงกชั่นเหลานี้ไดแก 

ฟงกชั่นในตารางท่ี 3-8 

ตารางที่ 3-8 ตารางแสดงรายชื่อฟงกชั่นชนิด Dabatase 

ช่ือฟงกชัน คําอธิบายฟงกชัน  

DAVERAGE() ใชสําหรับหาคาเฉลี่ยท่ีปรากฎอยูในฟลด ซ่ึงเปนไปตามเง่ือนไขท่ีกําหนดไว 

DCOUNT() ใชสําหรับนับเซลลทุกเซลลท่ีมีตัวเลขปรากฎอยู  ซ่ึงเปนไปตามเง่ือนไขท่ีกําหนดไว 

DCOUNTA() ใชสําหรับนับเซลลทุกแถวท่ีไมไดเปนคาวาง ท่ีเปนไปตามเง่ือนไขท่ีกําหนดไว 

DMAX ใชสําหรับหาคาสูงสุด ท่ีปรากฎอยูในฟลด ซ่ึงเปนไปตามเง่ือนไขท่ีกําหนดไว 

DMIN ใชสําหรับหาคาต่ําสุดท่ีปรากฎอยูในฟลด ซ่ึงเปนไปตามเง่ือนไขท่ีกําหนดไว 

DSUM ใชสําหรับ หาผลรวมของทุกแถว ท่ีเปนไปตามเง่ือนไขท่ีกําหนดไว 

 

ยกตัวอยางท่ี 1 เชน จากรูปท่ี 3.12 เปนตารางขอมูลทะเบียนพนักงานของบริษัทสยาม

การคาจํากัด จากรูปดังกลาวตองการหาคาเฉลี่ยเงินเดือนของพนักงานท่ีอยูในแผนก Accounting 

 

รูปที่ 3.12 แสดงการหาผลลัพธ การใชฟงกชัน DAVERAGE 



84 บทท่ี 3 การเปลี่ยนขอมูลใหเปนสารสนเทศในเชิงธุรกิจ ดวยโปรแกรมสําเร็จรูป 

จากรูปท่ี 3.12  เปนตารางขอมูลทะเบียนพนักงานของบริษัทสยามการคาจํากัด จากรูป

ดังกลาวตองการหาคาเฉลี่ยเงินเดือนของพนักงานท่ีอยูในแผนก Accounting จึงไดทําการสรางตาราง

เพ่ิมไวดานบน  ซ่ึงตารางท่ีเพ่ิมมานี้สามารถวางไวดานลางหรือ ดานขางก็ได แตตองมีระยะหาง

ระหวางตารางคําตอบนี้ กับ ตารางขอมูลหรือ database อยางนอย 1 แถว หรือ 1 คอลัมน เพ่ือให 

Excel แยกแยะไดวา สวนไหนเปนตารางคําตอบ สวนไหนเปนตารางขอมูล ในกรณีนี้ตารางคําตอบคือ

ชวงท่ีอยูในเซลล D4:F5 โดยกําหนดใหเง่ือนไขอยูในเซลล D4:D5 สวนคําตอบใสไวใน F4:F5  เสร็จ

แลวกําหนดเง่ือนไขไวดังรูปท่ี 3.12   

ในเซลล F5  ใหใสสูตรคํานวณ ดังตอไปนี้   =DAVERAGE(A7:G121 ,"salary" ,D4:D5)  

ความหมายของสูตรคือ  

- ใชฟงกชั่น DAVERAGE    

- กําหนดชวงขอมูลท่ีเปนตารางขอมูล A7:G121   

- ทําการหาคาเฉลี่ยท่ีฟลด Salary 

- ตารางขอมูลสวนท่ีเปนเง่ือนไขอยูท่ีเซลล D4:D5 ซ่ึงมีความหมายวา เง่ือนไขคือ ฟลด 

Department จะตองเปนคําวา Accounting 

ตารางคําตอบท่ีไดดูในรูปท่ี 3.12 

 

ยกตัวอยางท่ี 2  จากรูปท่ี 3.13 เปนตารางขอมูลทะเบียนพนักงานของบริษัทสยามการคา

จํากัด จากรูปดังกลาวตองการหา เงินเดือนสูงสุดของแผนกบัญชี  คาเฉลี่ยเงินเดือนของพนักงานท่ีอยู

ในแผนกบัญชี เงินเดือนต่ําสุดของแผนกบัญชี และพนักงานในแผนกบัญชีมีท้ังหมดก่ีคน 

- 

 

รูปที่ 3.13 แสดงผลลัพธ จากการใชฟงกชนัชนิด Database  
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จากรูปท่ี 3.13  เปนตารางขอมูลทะเบียนพนักงานของบริษัทสยามการคาจํากัด จากรูป

ดังกลาว ใหทําการสรางตารางเพ่ิมตอจากรูปท่ี 3.12 ดานบน โดยทําในเซลล D4:H5  แลวใสสูตร

คํานวณลงไปในเซลล E5:H5 ตามในรูปท่ี 3.14 
 

 

รูปที่ 3.14 แสดงการหาผลลัพธ การใชฟงกชันชนิด Database 

จะเห็นไดวาลักษณะการใสฟงกชัน จะคลายกันหมดท้ัง 4 เซลล เพียงแคเปลี่ยนชื่อฟงกชัน

เทานั้น และขอดีของฟงกชันเหลานี้คือเพียงแคเปลี่ยนเง่ือนไขในชอง D5 เชนในท่ีนี้เปลี่ยนจากชื่อ

แผนก Accournting เปน Art  Excel ก็สามารถหาคําตอบท่ีเหลือท้ังหมดใหไดอยางรวดเร็ว โดยไม

ตองเปลี่ยนฟงกชันเลย ดังในรูปท่ี 3.15 

 

 

รูปที่ 3.15 แสดงผลลัพธ การใชฟงกชันชนิด Database โดยเปลี่ยนเงื่อนไข 
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 2. การนําเสนอข้อมูล  

2.1 การนําเสนอขอมูลดวยกราฟ (Chart) 

Chart หรือ กราฟหรือแผนภูมิ เปนรูปแบบการแสดงผลชนิดหนึ่งท่ีจะชวยใหขอมูลมีความ

นาสนใจมากข้ึน และผูชมก็จะสามารถจะสังเกตแนวโนมความเปลี่ยนแปลงตาง ๆ ไดงายข้ึนกวาท่ีจะ

นําขอมูลนับรอยนับพันตัวมาดู การสรางแผนภูมิใน Excel มักสรางดวยระบบอัตโนมัติ ซ่ึงจะทําใหได

แผนภูมิในแบบท่ีตองการอยางรวดเร็ว และสามารถนําไปปรับแตงภายหลังไดตามตองการ  

ประเภทของกราฟ  (Chart type) 

ประเภทของกราฟมี 11 ชนิด ซ่ึงมีคุณลักษณะดังนี้ 

ตารางที่ 3-9 ตารางแสดงประเภทของกราฟ 

Chart Type คุณลักษณะ 

Column 

Charts 

เปรียบเทียบขอมูลแตละคาใหเห็นความแตกตางอยางชัดเจน มักใชกับจํานวนของสิ่งตาง ๆ  

เชน จํานวนเงิน จํานวนคน เปนตน 

Line Charts แสดงคาของขอมูลและแนวโนมภายในชวงระยะเวลาหนึ่ง 

Pie Charts แสดงความสัมพันธเชิงเปรียบเทียบระหวางขอมูลแตละคากับผลรวมของขอมูลทั้งหมด 

Bar Charts เปรียบเทียบขอมูลใหเห็นความแตกตางอยางชัดเจนเชนกัน เพียงแตแทงกราฟจะอยูใน

แนวนอน ซึ่งใหความรูสึกในดานเวลาหรือระยะทางมากกวา 

Area Charts ลักษณะคลายกราฟเสน แตจะแสดงใหเห็นผลรวมและแนวโนมผลรวมของขอมูลทั้งหมดดวย 

XY ( scatter) 

Charts 

แสดงความสัมพันธระหวางตัวเลข 2 กลุม เพื่อการวิ เคราะหแบบเชิงเสน (Linear 

regression) หรือแสดงความสัมพันธระหวางตัวเลขหลาย ๆ ชุด เพื่อดูการแบงชวงหรือจับ

กลุมของขอมูล 

Stock Charts (หรือเรียกอีกอยางวากราฟhigh-low-close)เปนกราฟที่ใชแสดงความเปลี่ยนแปลงของ

ขอมูลใดๆ (ที่ประกอบไปดวยคาสูงสุด, ต่ําสุดและคาอ่ืนๆอีกคาหนึ่ง) ณแตละจุดของเวยลา

ภายในชวงระยะเวลาหนึ่งโดยมากมักใชกับราคาหุนเพราะสามารถแสดงราคาสูงสุด-ต่ําสุด

และราคาปดไดด ี

Surface 

Charts 

ใหหาจุดสมดุลของผลลัพธจากตัวแปร 2 ตัว โดยตัวหนึ่งอยูทางแกน X และอีกตัวอยูทาง

แกน Y พื้นผิวในกราฟที่มีสีเดียวกัน คือจุดที่ความสัมพันธระหวางตัวแปรทั้งสองตัวแปรทั้ง

สองใหผลลัพธออกมาเทาหรือใกลเคียงกัน 

Doughnut 

Charts 

คลายกราฟวงกลม แตซับซอนกวา เพราะกราฟวงกลมใชแสดงความสัมพันธของขอมูลได

เพียงชุดเดียว แตกราฟรูปโดนัทสามารถเปรียบเทียบขอมูลตั้งแต 2 ชุดข้ึนไปไดดวย 

Bubble 

Charts 

คลายกับกราฟ XY (Scatter) แตมีตัวแปรไดเพียง 3 ตัว โดยที่ตัวที่ 3 จะแสดงดวยขนาดของ

ฟองสบู 

 Radar Charts แสดงความสัมพันธระหวางขอมูลแตละชุดในรูปองขอบเขตพื้นที่ที่ขอมูลชุดนั้น ๆ 

ครอบครอง โดยขอมูลแตละชุดจะมีจุดศูนยกลางรวมกัน 
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การสรางกราฟดวย Excel 2016 ยังคงมีพ้ืนฐานในการสรางคลายกับเวอรชั่นเกา ท่ีแตกตาง

กันคือ Excel 2016 ใชงานไดงายกวาโดยมีลักษณะการทํางานเปนแบบ มีรูปแบบสําเร็จรูป (Gallery) 

ใหคลิกเลือกใชไดหลากหลายมากข้ึนและเพ่ิม Recommended Chart สวยกวาเวอรชั่นเกา เรื่อง

พ้ืนฐานเก่ียวกับกราฟท่ีควรทราบมีดังนี้   

Chart Type  

กราฟมีหลายประเภท ซ่ึงเหมาะสําหรับขอมูลหรือวัตถุประสงคท่ีแตกตางกัน สวนประเภท

ยอยของกราฟท้ังหลายนั้นสวนมากจะเปนเพียงกลเม็ดท่ีทําใหรูปกราฟดูนาสนใจข้ึน สวยข้ึนเทานั้น 

เชน ทําเปนแบบ 2 มิติหรือ 3 มิติ ทรงกลม หรือทรงกระบอก เปนตน 

 

รูปที่ 3.16 แสดงกลองโตตอบสาํหรับเลือกประเภทกราฟ 

Location  

เปนคําสั่งสําหรับเลือกวิธีการวางกราฟท่ีสรางเสร็จแลวสามารถเลือกวางกราฟ หรือแสดงผล

กราฟ ได 2 วิธี คือ 

1) ไวในเวิรกชีตปจจุบัน (Active Sheet) โดยจะมีลักษณะเปนรูปภาพรูปหนึ่งวางไว

บนเวิรกชีต ซ่ึงวิธีนี้ใชแสดงกราฟในลักษณะเปนภาพประกอบขอมูลตัวเลขในเวิรกชี

ตนอกจากจะมีลักษณะคลายรูปภาพแลว ยังสามารถนําวิธีการจัดการรูปภาพท่ัวไป

มาใชไดดวยเชน การลบ ปรับขนาด และเคลื่อนยาย เปนตน 
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2) หรือวางไวใน Chart Sheet ซ่ึงจะใชสําหรับเก็บกราฟโดยเฉพาะ ซ่ึงวิธีนี้ใชเม่ือ

ตองการแสดงกราฟเพียงอยางเดียว   

 

 

 

 

 

 

รูปที่ 3.17 แสดงกลองโตตอบสาํหรับ Move Chart 

วิธีการปรับแตงสวนตาง ๆ ของกราฟ 

3) คลิกท่ีกราฟ จะปรากฏ Contexture Tab ของ Chart Tools ปรากฏออกมา คลิกเลือก 

Design 

4) คลิกเลือกรูปแบบท่ีตองการ 

 
 

รูปที่ 3.18 แสดงการปรับแตงของ Chart 

Data Series   

คือชุดขอมูลท่ีใชในการสรางกราฟ เปนเรื่องสําคัญท่ีตองทําความเขาใจ เพราะลักษณะของ

กราฟจะข้ึนกับชุดขอมูลท่ีกําหนดใหนํามาทําเปนกราฟ ซ่ึงถาเลือกผิดก็อาจไดกราฟท่ีไมสื่อความหมาย

หรือสื่อความหมายผิด ๆ ได เม่ือมีการเปลี่ยนแปลงขอมูลท่ีใชสรางกราฟในเวิรกชีต รูปกราฟก็จะถูก

เปลี่ยนตามไปดวย เชน ถาเปนกราฟแทง เม่ือเพ่ิมคาของขอมูล แทงกราฟก็จะสูงข้ึน เปนตน ดังนั้นไม

ตองกังวลวาเม่ือสรางกราฟไปแลว หากขอมูลมีการเปลี่ยนแปลงแลวจะตองมานั่งสรางใหมและขอ

สําคัญอีกประการเก่ียวกับ data Series คือ จะตองเปนขอมูลชนิดตัวเลข หรือ Number เทานั้น 

 

 

 

1 

2 
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รูปที่ 3.19 แสดงกลองโตตอบสาํหรับการเลือกขอมูลที่นํามาใชสรางกราฟ 

เม่ือตองการเปลี่ยนชนิดของแผนภูมิท่ีเลือก  

1) ใหคลิกแท็บ Design แลวคลิกปุม Change Chart Type จากกลุมคําสั่ง Type  

2) คลิกเลือกประเภทกราฟท่ีตองการเปลี่ยนจากกลองโตตอบแลวคลิก OK  
การสลับแถวและคอลัมนในแผนภูมิท่ีเลือก 

3) บนแท็บ Design คลิกเลือกปุม Switch Row/Column จากกลุมคําสั่ง Data หรือ  

บนแท็บ Design คลิกเลือกปุม Data จากกลุมคําสั่ง Data 1 หรือ  

คลิกขวาท่ีเสนขอบของแผนภูมิหรือพ้ืนท่ีขอมูลและคลิกเลือก Data  

4) ในกลองโตตอบ Select Data Source ใหคลิกปุม Switch Row/Column แลว

คลิก OK 

2.2 นําเสนอดวยการจัดรูปแบบตามเงื่อนไข (Conditional Formatting) 

การใช Conditional Formatting เปนการจัดรูปแบบเซลลตามเง่ือนไขตาง ๆ ท่ี Excel ได

เตรียมไวให ซ่ึงมีการพัฒนาใหใชงานไดสะดวกข้ึนมากกวาเดิมมาก โดยใน Excel 2016 ไดเพ่ิม

คุณสมบัติในคําสั่งนี้ข้ึนอยางมากเพ่ือทําใหการตบแตงเซลลแบบมีเง่ือนไขนี้ ใชงานงายข้ึน เรียกวา

พรอมใชงานสําหรับทุกสถานการณ เพราะมีรูปแบบเตรียมไวลวงหนาใหมากมาย เชน  Highlight 

Cells  Top/ Bottom  Data Bars  Color Scales  Icon Sets 
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รูปที่ 3.20 แสดงคําสัง่ตาง ๆ ใน Conditional Formatting   

นอกจากนี้คุณยังสามารถกําหนดกฎตั้งแตเริ่มตนดวยการใช กลองโตตอบ New Formatting 

Rule ซ่ึงมีตัวเลือกใหใชมากมาย พรอมมีคําอธิบายในการแกไขพ้ืนท่ี หรือกําหนดกฎตาง ๆ ท่ีแตกตาง

กันออกไปข้ึนอยูกับการเลือกและความตองการของผูใชงาน  นอกจากนี้ในการเลือกชนิดของกฎจาก

รายการจะสามารถกําหนดเง่ือนไขไดหลายเง่ือนไขในชวงเซลลขอมูลเดียวกัน หรือในตารางเดียวกัน  

 

 

 

 

 

 

 

1 2 3 

4 5
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รูปที่ 3.21 แสดงหนาตางโตตอบ ในการกําหนดกฎเขาไปใหมดวย New Formatting Rule 

กฎท้ังหมดท่ีสรางข้ึนจะถูกระบุไวในกลองโตตอบชื่อ Conditional Formatting Rules 

Manager  ซ่ึงเปนหนาตางท่ีใชควบคุมกฎตาง ๆ ท่ีสรางข้ึนมาท้ังหมด หนาตางนี้จะสามารถจัดการกฎ

ไดหลายอยาง ไดแก   

1) การสราง  การแกไขกฎ  และลบกฎ  ท่ีเลือก  

2) การเลือกปรับลําดับท่ีในการประมวลผลตามกฎ   

3) การระบุวาจะให Excel ควรจะหยุดการประมวลผลกฎเซลลหลังจากท่ีไดพบ

เง่ือนไข จากกฎท่ีเลือก 

4) ตารางกฎท้ังหมดท่ีตั้งไวในเซลล 

 

 

 

 

 

 

 

รูปที่ 3.22 แสดงหนาตางโตตอบที่ใชควบคุมกฎตาง ๆ Conditional Formatting Rules Manager 

Highlight Cell Rules 

เปนคําสั่งท่ีสั่งให Excel ทําการ Highlight หรือ ใสสีเพ่ือเนนขอมูลในเซลลท่ีเปนไปตาม

เง่ือนไขท่ีตั้งข้ึน เม่ือคลิกเลือกคําสั่งนี้จะปรากฎคําสั่งเพ่ิมมาใหอีก 7 คําสั่งยอย ดังตอไปนี้ 
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 Greater Than มากกวา  

 Less Than นอยกวา 

 Between อยูระหวาง 

 Equal To เทากับ 

 Text that Contains  ตัวอักษรท่ีประกอบไปดวย ... 

 A Date Occurring วันท่ี ตามท่ีกําหนด 

 Duplicate Values คาท่ีซํ้ากัน 

 More Rules  กําหนดกฎเพ่ิมเติมเอง 

ตัวอยางการใชงานจากรูปท่ี 3.23 ถาตองการเนนราคาหนังสือท่ีสูงกวา 350.- บาท มีวิธีการทําคือ 

1) คลิกเลือกกลุมเซลลราคาตอหนวย คือเซลล C4:C13 

2) เลือกปุมคําสั่ง Conditional Formatting จากแท็บ Home กลุมคําสั่ง Styles  

แลวเลือก Highlight Cell Rules >> Greater Than  จะปรากฏกลองโตตอบ 

Greater Than  

3) ใสเลข 350 ลงไปในชองท่ีอยูใตคําสั่ง Format cells that are greater than :  

4) เลือกรูปแบบท่ีตองการใหแสดงในชอง With หรืออาจเลือกแบบอ่ืนเองตามใจชอบก็

ไดเสร็จแลวกดปุม OK 

  

 

 

 

 

 

 

 

 

 

 

 

 

รูปที่ 3.23 แสดงข้ันตอนการสรางกฎข้ึน Highlight ขอมูลแบบรวดเร็ว 

3) 

1 

4 
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ถาตองการแกไขกฏ หรือเง่ือนไขเพ่ิมเติมสามารถกดปุม More Rules…. เพ่ือตั้งคาตางๆ 

เพ่ิมเติมไดดังนี้ 

1) เลือกประเภทของการตั้งกฎ 

2) เลือกสิ่งท่ีจะนํามาเปรียบเทียบ 

3) เลือกรปูแบบการเปรียบเทียบ 

4) เลือกการจัดรูปแบบเซลลเม่ือขอมูลเปนไปตามกฎ หรือเปนไปตามเง่ือนไข 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

รูปที่ 3.24 แสดงข้ันตอนการตั้งกฎสําหรับทํา Highlight ขอมูลที่ตองการแบบกําหนดกฏเพิ่มเติมเอง 
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Top/Bottom Rules 

เปนคําสั่งท่ีสั่งให Excel ทําการ highlight หรือ ใสสีเพ่ือเนนขอมูลในเซลลท่ีมีการจัดอันดับ

ตามเง่ือนไขท่ีตั้งข้ึน เม่ือคลิกเลือกคําสั่งนี้จะปรากฎคําสั่งเพ่ิมมาใหอีก 7 คําสั่งยอย ดังตอไปนี้ 

 Top 10 Item จัดอันดับยอดเยี่ยมจากขอมูลในเซลล 

 

 

 Top 10 %  จัดอันดับยอดเยี่ยมจากรอยละของขอมูล 

 Bottom 10 Item  จัดอันดับยอดแยจากขอมูลในเซลล 

 Bottom 10 %  จัดอันดับยอดแยจากรอยละของขอมูล 

 Above Average  เนนขอมูลท่ีสูงกวาคาเฉลี่ย 

 Below Average  เนนขอมูลท่ีต่ํากวาคาเฉลี่ย 

 More Rules  กําหนดกฎเพ่ิมเติมเอง 

 

ตัวอยางการใชงานจากรูปท่ี 3.25 ตองการเนนราคาหนังสือท่ีอยูในอันดับสูงสุด 3 อันดับแรก 

มีวิธีการทําคือ 

1) คลิกเลือกกลุมเซลลราคาตอหนวย คือเซลล C4:C13 

2) เลือกปุมคําสั่ง Conditional Formatting จากแท็บ Home กลุมคําสั่ง Styles แลว

เลือก Top/Bottom Rules>> Top 10 Items…จะปรากฎไดอะล็อกบอกสดังใน

ภาพ  

3) ใสเลข 3 ลงไปในชองท่ีอยูใตคําสั่ง Format cells that rank in the TOP :  

4) เลือกรูปแบบท่ีตองการใหแสดงในชอง With หรืออาจเลือกแบบอ่ืนเองตามใจชอบก็

ไดเสร็จแลวกดปุม OK 

 

 

 

 

 

 

 

 

 

รูปที่ 3.25 แสดงข้ันตอนการตั้งกฎแบบจัดอันดับ Top / Bottom  
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ถาตองการแกไขกฏ หรือเง่ือนไขเพ่ิมเติมสามารถกดปุม More Rules…. เพ่ือตั้งคาตางๆ 

เพ่ิมเติมไดดังนี้ 

1) เลือกประเภทของการตั้งกฎ 

2) เลือกประเภทวา ตองการจัดอันดับยอดเยี่ยม หรือยอดแย  

3) ใสจํานวนอันดับท่ีตองการจัด 

4) ใส  เม่ือตองการใหคิดเปนรอยละจากขอมูลท้ังหมดท่ีเลือกไวตอนแรก 

5) เลือกการจัดรูปแบบเซลลเม่ือขอมูลเปนไปตามกฎ หรือเปนไปตามเง่ือนไข 

 

 

 

 

 

 

 

 

 

 

 

 

รูปที่ 3.26 แสดงข้ันตอนการตั้งกฎสําหรับทํา Top/Bottom แบบกําหนดกฏเพิ่มเติมเอง 
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Data Bars 

เปนคําสั่งท่ีสั่งให Excel ใสแถบสีเพ่ือใหสามารถอานหรือสังเกตุขอมูลในเซลลไดสะดวกข้ึน  โดย

แถบสีแตละอันของแตละเซลลจะมีขนาดท่ีสัมพันธกันกับขอมูลในเซลล  เม่ือคลิกเลือกคําสั่งนี้จะปรากฎ

สาใหเลือก 6 สีดังรูป  ตัวอยางการใชงาน จากภาพ ตองการใสแถบสีใหกับจํานวนหนังสือท่ีขายได  เพ่ือให

สังเกตุเห็นงาย ๆ วาขายหนังสือเลมใดไดมากท่ีสุด มีวิธีการทําคือ 

1) คลิกเลือกกลุมเซลลจํานวนขาย คือเซลล D4:D13 

2) เลือกปุมคําสั่ง Conditional Formatting จากแท็บ Home กลุมคําสั่ง Styles แลว

เลือก Data Bars>>คลิกเลือกสีท่ีตองการ    

 

 

 

 

 

 

 

 

 

รูปที่ 3.27 แสดงตัวอยางผลลัพธจากการใชคําสัง่ Data Bars 

แตถาตองการตั้งคาเพ่ิมเติม กดท่ีปุม More Rules… เพ่ือตั้งคาตางๆ ไดดังนี้ 

1) เลือกประเภทของการตั้งกฎ 

2) เลือกรูปแบบเปนชนิด Data Bar 

3) ใส  เม่ือตองการใหแสดงเฉพาะแถบสี  และซอนตัวเลขในเซลลไว 

4) เลือกชนิดสําหรับแถบสีสั้น และเลือกชนิดสําหรับแถบสียาว 

5) เลือกรูปแบบการเติมสี  สี  รูปแบบเสน และสีเสน 

6) เลือกรูปแบบมูลคาติดลบและแกน   กับเลือกทิศทางของแถบบาร   
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รูปที่ 3.28 แสดงข้ันตอนการตั้งกฎสําหรับทํา Data Bars  แบบกําหนดกฏเพิ่มเติมเอง 

Color Scales 

เปนคําสั่งท่ีสั่งให Excel ใสแถบสีเพ่ือใหสามารถอานหรือสังเกตุ

ขอมูลในเซลลไดสะดวกข้ึน โดยแถบสีแตละอันของแตละเซลลท่ีจะ

ปรากฎ จะมีการไลระดับสีตามความสัมพันธของขอมูล เชน ขอมูลใน

เซลลไหนมากสุด จะสีเขมสุด ขอมูลในเซลลไหน นอยสุด ก็จะสีออนท่ีสุด 

ในบรรดาเซลลท้ังหมดท่ีเลือกไวเม่ือคลิกเลือกคําสั่งนี้จะปรากฎแถบสีมา

ใหอีก 8 สีดังรูป  

ตัวอยางการใชงาน จากภาพ ตองการใสแถบสีใหกับจํานวนหนังสือท่ีขายได  เพ่ือใหสังเกตุ

เห็นงาย ๆ วาขายหนังสือเลมใดไดมากท่ีสุด มีวิธีการทําคือ 

1) คลิกเลือกกลุมเซลลจํานวนขาย คือเซลล D4:D13 

2) เลือกปุมคําสั่ง Conditional Formatting จากแท็บ Home กลุมคําสั่ง Styles  

3) แลวเลือก Color Scales>>คลิกเลือกสี   
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รูปที่ 3.29 แสดงตัวอยางผลลัพธจากการใชคําสัง่ Color Scales 

ถาตองการตั้งคาเพ่ิมเติมคลิกเลือกคําสั่ง More Rules… แลวตั้งคาไดดังนี้ 

4) เลือกประเภทของการตั้งกฎ 

5) เลือกรูปแบบซ่ึงมี 2-Color Scale  กับ 3-Color Scale 

6) เลือกชนิดและสีสําหรับแถบสีเขม และเลือกชนิดและสีสําหรับแถบสีออน 

 

 

 

 

 

 

 

 

 

 

 

 

 

รูปที่ 3.30 แสดงข้ันตอนการตั้งกฎสําหรับทํา Color Scales  แบบกําหนดกฏเพิ่มเติมเอง 
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Icon Sets 

เปนคําสั่งท่ีสั่งให Excel ใสชุดไอคอน หรือชุดสัญลักษณ เพ่ือใหสามารถอานหรือสังเกตุขอมูล

ในเซลลไดสะดวกข้ึน โดยสัญลักษณแตละอันของแตละเซลลท่ีจะปรากฎ จะมีความหมายแตกตางกัน

ตามกฏท่ีตั้งข้ึน เชน ชุดไอคอนรูปลูกศร 3 สี เขียว, เหลือง, แดง ตั้งกฎไววา  

 สีเขียวหมายความวา ขอมูลในเซลลสูงกวา 67%  เม่ือเทียบ กับขอมูลท้ังหมดท่ีเลือกไว 

 สีเหลืองหมายความวา ขอมูลในเซลลอยูในชวง มากกวา 33% – 66% เม่ือเทียบกับ

ขอมูลท้ังหมดท่ีเลือกไว 

 สีแดงหมายความวา ขอมูลในเซลลต่ํากวา 33% เม่ือเทียบกับขอมูลท้ังหมดท่ีเลือกไว 

ซ่ึงกฎดังกลาวนี้เปลี่ยนแปลงไดตามความตองการของผูใชงานแตในเบื้องตน Excel จะตั้งกฎ

นี้มาใหกอนและเม่ือคลิกเลือกคําสั่งนี้จะปรากฎชุดไอคอนมาใหเลือกอีก  

ตัวอยางการใชงาน จากภาพ ตองการใสชุดไอคอนใหกับจํานวนหนังสือท่ีขายได  เพ่ือให

สังเกตุเห็นงาย ๆ วาหนังสือเลมใดขายไดมากนอยเทาไร เม่ือเทียบกับชุดขอมูลท้ังหมดท่ีเลือกไวมี

วิธีการทําคือ 

1) คลิกเลือกกลุมเซลลจํานวนขาย คือเซลล D4:D13 

2) เลือกปุมคําสั่ง Conditional Formatting จากแท็บ Home กลุมคําสั่ง Styles  

3) แลวเลือก Icon Set >>คลิกรูปแบบชุดไอคอนท่ีตองการ  จะไดผลลัพธตามตองการ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

รูปที่ 3.31 แสดงตัวอยางผลลัพธจากการใชคําสัง่ Icon Sets 
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ถาตองการแกไขกฎเพ่ิมเติม คลิกเลือกคําสั่ง More Rules จะปรากฎไดอะล็อกบอกสของ 

New Formattiong Rule ซ่ึงสามารถเปลี่ยนแปลงแกไขเพ่ิมเติมไดดังนี้ 

1) เลือกประเภทของการตั้งกฎ 

2) เลือกรปูแบบเปน Icon Sets 

3) เลือกรูปแบบสัญลักษณ ถาเปลี่ยนรูปแบบ กฏดานลางก็จะเปลี่ยนตาม 

4) ปุมสลับการเรียง  และใส  เม่ือตองการใหแสดงเฉพาะสัญลักษณ และซอน

ตัวเลขในเซลลไว 

5) เลือกสัญลักษณ 

6) เลือกประเภทการเปรียบเทียบ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

รูปที่ 3.32 แสดงข้ันตอนการตั้งกฎสําหรับทํา Icon Sets  แบบกําหนดกฏเพิ่มเติมเอง 

การสรางเงื่อนไขหรือกฎใหมข้ึนมาเอง 
นอกจากกฏที่กลาวมาจากขางตนExcel ยังมีรูปแบบในการตั้งกฎให

เลือกใชจากคําสั่ง New Rule… ไดอีก 2 แบบคือ  

1) Format only unique or duplicate values ซ่ึงใชสําหรับจัดรูปแบบใหกับเซลล

ท่ีมีขอมูลท่ีมีขอมูลซํ้ากัน Duplicate หรือ จัดรูปแบบใหกับเซลลท่ีไมซํ้ากับขอมูล

ไหนเลย Unique   

a. เลือกประเภทการตั้งกฎ 

1 

2 4 

6 
3 

5 
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b. เลือกวาจะใหจัดกับขอมูลท่ีซํ้ากัน หรือไมซํ้ากัน 

c. เลือกรูปแบบท่ีตองการเม่ือเง่ือนไขเปนจริง 

2) Use a formula to determine which cells to format ซ่ึงใชสําหรับจัดรูปแบบ

ใหกับเซลลโดยใชสูตร formula หรือ function 

a. เลือกประเภทการตั้งกฎ 

b. ใสสูตรคํานวณหรือฟงกชัน 

c. เลือกรูปแบบท่ีตองการเม่ือเง่ือนไขเปนจริง 

 

 

 

 

 

 

 

 

 

 

 

รูปที่ 3.33 แสดงข้ันตอนการตัง้กฎ แบบ Unique/Duplicate และ Formula  

การลบเงื่อนไข 

เม่ือตองการลบรูปแบบท่ีสรางข้ึนโดยใช คําสั่ง Conditional formatting สามารถทําไดดังนี้ 

1) คลิกเลือกเซลลท่ีตองการลบรูปแบบ 

2) คลิกเลือกคําสั่งConditional Formatting จาก Ribbon Home แลวเลือก Clear Rules 

3) คลิกเลือกคําสั่งลบแบบใดแบบหนึ่งจากคําสั่งตอไปนี้ 

a. Clear Rules from Selected 

Cells ใหทําการลบกฎหรือ

เง่ือนไขออกจากเซลลท่ีเลือก 

b. Clear Rules from Entire sheet ใหทําการลบกฎหรือเง่ือนไขออกจาก

ท้ังเวิรกชีต 

c. Clear Rules from This Table ใหทําการลบกฎหรือเง่ือนไขออกจาก

ตาราง (List หรือ database) 

d. Clear Rules from This PivotTable ใหทําการลบกฎหรือเง่ือนไขออก

จาก PivotTable ท่ีเลือก 

1)b 

1)c 

2)a 

2)b 

2)c 

1)a 
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 3. การวเิคราะห์ข้อมูลและการจัดระเบียบข้อมูล  

       (Analyzing and Organizing Data) 

สมุดงาน Excel สมุดเดียวสามารถมีมากกวาหนึ่งลานแถวและ 16,000 คอลัมน ถึงแมวา

อาจจะไมไดทํางานกับขอมูลจํานวนมากขนาดนั้น แตก็มีบอยครั้งที่อาจจําเปนตองคนหาเฉพาะ

ประเภทของขอมูลภายในชุดขอมูลหรือในตาราง Excel ซึ ่งผู ใชสามารถกรองขอมูลที ่จะแสดง

เฉพาะเรคคอรดที่ตรงกับเงื่อนไขที่เฉพาะเจาะจง และเรียงลําดับขอมูลเพื่อจัดระเบียบในลักษณะท่ี

เปนตรรกะ นอกจากนี้ยังสามารถจัดรูปแบบเซลลที่อยูภายใน ระบุขอมูลชวงที่จะเห็นไดใหแสดง

เฉพาะขอมูลที่ตรงตามชวงของเงื่อนไข บทนี้จะแนะนําในการศึกษาวิธีการกรองขอมูลเพื่อคนหา

รายการท่ีตรงกับเกณฑท่ีระบุ การเรียงลําดับขอมูลโดยการทีละเขตขอมูล หรือหลายเขตขอมูลพรอมๆ 

กัน และการจัดรูปแบบขอมูลโดยใหข้ึนอยูกับชุดของเง่ือนไข เปนตน 

3.1  หลกัการเก็บขอมูลเพ่ือใช Excel เปนฐานขอมูล 

ความสามารถท่ีสําคัญอีกประการหนึ่งของ Excel คือ ความสามารถในการจัดระเบียบขอมูล

ปริมาณมากๆ เพ่ือใหเปนระเบียบเม่ือตองการนําขอมูลมาใชไดอีก แตการใสขอมูลลงคอมพิวเตอรก็

ไมใชวาจะทําไดงาย ๆ ถานําขอมูลใสไวไมเปนระบบระเบียบ อาจจะนําไปใชงานไดยาก ดังนั้นจึงตอง

มีการออกแบบระบบการเก็บขอมูลท่ีดีพอ  ซ่ึงระบบการจัดเก็บขอมูลก็คือ ฐานขอมูล (Database) 

นั่นเอง 

ฐานขอมูล (Database) คือการนําขอมูลจํานวนมาก ๆ มาเก็บไวดวยกัน โดยมีรูปแบบการ

จัดขอมูลท่ีเปนระบบ คือมีโครงสรางเหมือนกัน เพ่ือใหสะดวกในการนําไปใชงานในภายหลัง เชน 

รายนามลูกคา หรือ ยอดขายของรานคา เปนตน โปรแกรม Excel สามารถชวยใหสรางฐานขอมูลได 

โดยมีคุณสมบัติในการจัดเก็บขอมูลและตรวจสอบประเภทของขอมูลท่ีใสเขามาไดวาถูกตองหรือไม 

และยังสามารถจัดเรียงขอมูล และกรองเฉพาะขอมูลท่ีสนใจไดงาย  

สวนประกอบพ้ืนฐานของฐานขอมูลคือ ตาราง (Table) ภายในตารางจะมีขอมูลท่ีถูกจัดเก็บ

อยูในรูปแบบแถว (Row) และคอลัมน (Column) โดยแตละแถว หรือ row จะถูกเรียกใหมวา "เรคค

อรด" (Record ) และแตละแถวแนวตั้งท่ีเรียกวาคอลัมน หรือ Column จะถูกเรียกใหมวา "ฟลด" 

(Field)  จะเห็นวาการเก็บขอมูลลงในตารางนัน้มีลักษณะเหมือนกับตารางใน Excel นั่นเอง ดังนั้นจึง

มีผูใชจํานวนหนึ่งท่ีนิยมเก็บขอมูลในลักษณะฐานขอมูลนี้ไวกับ Excel เนื่องจากมีความคุนเคยกับ

โปรแกรมนี้มากกวา และไมจําเปนตองมีความรูในเรื่องของ Database เปนอยางดี ก็สามารถใชงาน

ฐานขอมูลของ Excel นี้ได ซ่ึงใน Excel 2010 มีการปรับปรุงประสิทธิภาพ และรูปแบบการใชคําสั่ง

ใหใชงานงายข้ึน หลากหลายมากข้ึน และครอบคลุมความตองการมากข้ึน 
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Microsoft Access  คือโปรแกรมท่ีใชสําหรับจัดการฐานขอมูล ซึ่งมีความสามารถท่ีดีกวา Excel แตถึงแมวา Excel จะ

ชวยใหสรางฐานขอมูลได แตโปรแกรม Access จะมีความสามารถดานฐานขอมูลท่ีโดดเดนกวา Excel 

เพราะสามารถจัดการขอมลูแบบ RDBMS (Relational Database Management System) ได  แต

เน่ืองจากโปรแกรม Access ใชงานคอนขางยาก  จึงมักจะนํา Excel มาใชจัดทําฐานขอมูล ในกรณีท่ี

ฐานขอมูลไมซับซอนมากนัก   

กฎการใช Excel ในลักษณะเปนฐานขอมูล 

การสรางฐานขอมูลใน Excel นั้นงายมากเนื่องจากวิธีการทําเหมือนกับการสรางเวิรกชีท

ธรรมดา ๆ นั่นเอง เพียงแตจะตองจัดโครงสรางใหเปนไปตามเง่ือนไขบางอยาง ดังนี้ 

(1) ฐานขอมูลของ Excel จะอยูในรูป รายการขอมูล หรือ ลิสต (List)  

(2) ขอมูลแตละแถวในลิสตถือเปน 1 record  คําวา record เปนศัพทดานฐานขอมูลหมายถึง

กลุมของขอมูลหลาย ๆ เรื่องท่ีใชอธิบายหรือบอกรายละเอียดของสิ่งของชิ้นเดียวกัน 

(3) ขอมูลในแตละคอลัมนจะเรียกวา ฟลด (Field) หมายถึง ท่ีสําหรับเก็บขอมูลซ่ึงจะมีขอมูล

เพียงหนึ่งเรื่องหรือหนึ่งอยางเทานั้นท่ีเก็บไวในคอลัมนแตละคอลัมน 

(4) แถวแรกของลิสตจะตองเปนชื่อฟลดเสมอ สวนแถวอ่ืน ๆ ก็คือขอมูลแตละเรคคอรด  

(5) หัวเรื่องของลิสตจะมีหรือไมก็ได แตถามีก็ตองใสแถววาง  ๆค่ันไวจากลิสตอยางนอย 1 แถวเสมอ 

 

 
 

รูปที่ 3.34 แสดงตัวอยางและสวนตาง ๆ ของ Database ใน Excel  

 

แถวแรกของลิสตเปนชื่อ Field 

รายการขอมูล  

หรือ List 

ขอมูลแตละแถว เรียกวา Record 
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กฎดังกลาวมีไวเพ่ือให Excel ไดทราบวาขอมูลบริเวณไหนท่ีมีลักษณะเปนฐานขอมูลหรือ 

List ซ่ึงเม่ือเปน List แลวจะมีคําสั่งท่ีใชสําหรับจัดการกับขอมูลเหลานั้นโดยเฉพาะไวให ซ่ึงอยูใน 

Ribbon  Data  คําสั่งสวนใหญมีลักษณะการใชงานคลายกับคําสั่งท่ีมีอยูในโปรแกรมประเภทจัดการ

ฐานขอมูล หรือ Database  ดังจะกลาวถึงตอไปนี้ 

3.2 การกรองขอมูล Filter Data 

เม่ือตองการคนหาขอมูลท่ีมีคาเฉพาะเจาะจง สามารถใชตัวกรองของ Excel 2010 ชวยได 

โดยเฉพาะเม่ือตองการกรองตามเง่ือนไขหลาย ๆ อยางพรอมกัน ผูใชจะสามารถใชตัวกรองเพ่ิมเติม

เพ่ือใหไดผลตามตองการ นอกจากนี้ยังมีความสามารถในการใชตัวกรองสําเร็จรูป เพ่ือหาคาท่ีตรงตาม

เง่ือนไขท่ีกําหนดได ประเภทเง่ือนไขท่ีแตกตางกันออกไป ไมใชวาตองข้ึนอยูกับรูปแบบตัวเลขอยาง

เดียว แตมีการเพ่ิมเง่ือนไขท่ีเก่ียวกับการจัดรูปแบบเซลลได เชน สีของเซลล สีแบบอักษรหรือไอคอน

ของเซลล  

สังเกตตัวอยางการใช Filter 

1) รูปกรวยแสดงวา มีการกรองท่ีฟลดนี้  

2) แสดงเฉพาะแถวท่ีตรงตามเง่ือนไขท่ีกรอง ชื่อแถวท่ีแสดงจะเปนสีน้ําเงิน 

3) แถวท่ีไมตรงตามเง่ือนไขจะไมแสดง หรือซอนไว 

 

 

รูปที่ 3.35 แสดงตัวอยางการใช Filter  

 

 

 

 

3 

1 

2 



 

เอกสารประกอบการสอนรายวิชา 720401 เทคโนโลยสีารสนเทศเพ่ือธุรกิจ 105 

ตองการแสดงแถวท่ีมีคาคอลัมนท่ีเฉพาะเจาะจง  

1) คลิกท่ีเซลลใด ๆ ในตารางท่ีตองเรียงลําดับ จากนั้นบนแท็บ Home 

ในกลุมคําสั่ง Edit ใหคลิกปุม Sort & Filter  แลวคลิก Filter   

 

หรือ คลิกท่ีเซลลใด ๆ ในตารางท่ีตองเรียงลําดับ จากนั้นบนแท็บ 

Data ในกลุมคําสั่ง Sort & Filter คลิกเลือกปุมคําสั่ง Filter   

 

2) คลิกท่ีลูกศรของ Filter ของคอลัมนท่ีคุณตองการกรอง แลวคลิกปุม 

Select All เพ่ือลางกลองกาเครื่องหมาย   

3) เลือกกลองกาเครื่องหมาย ท่ีมีคาของขอมูลท่ีตองการจะใหแสดงแลวคลกิตกลง  

 

รูปที่ 3.36 แสดงตัวอยางการใช Filter  

 

ตองการนําตัวกรองออก 

1) บนแท็บ Home ในกลุมคําสั่ง Edit ใหคลิกท่ี Sort & Filter แลวคลิกคําสั่ง Clear 

หรือ 

2) บนแท็บ Data ในกลุม Sort & Filter ใหคลิกท่ีปุม Clear 

 

 

2 

3 
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ตองการใชเกณฑการกรองท่ัวไป  

1) แสดงลูกศรตัวกรองแลวคลิกท่ีลูกศรของคอลัมนท่ีคุณตองการ เพ่ือกรอง  

2) ชี้ไปท่ี < Type> Filter แลวคลิกเกณฑท่ีคุณตองการกรองตาม ท่ีมีคาตามตองการ  

Type Filter จะมีหลายชนิด ข้ึนอยูกับขอมูลท่ีกรอกไวในเซลล   

a. Number Filters สําหรับกรองขอมูลชนิดตัวเลข 

b. Date Filter สําหรับกรองขอมูลชนิดวันท่ี 

c. Text Filter สําหรับกรองขอมูลชนิดขอความ 

3) ในกลองโตตอบ Custom Auto Filter ใหตรวจสอบคาท่ีใสไวใหเสร็จสมบูรณตาม

เง่ือนไขท่ีตองการ   

4) เสร็จแลวคลิกท่ี OK  

  

รูปที่ 3.37 แสดงตัวอยางการใช Filter  

ตองการสรางตัวกรองท่ีกําหนดเอง  

กรองขอมูลแบบสรางเงื่อนไขเอง ใชกรณีที่ตองการกําหนดเงื่อนไขของฟลดใดฟลดหนึ่งมากกวา 1 

เงื่อนไขในคร้ังเดียว หรือใชในกรณีที่ตองการเปรียบเทียบเงื่อนไขที่มีลักษณะมากกวาหรือนอยกวา 

ยกตัวอยางเชน ตองการใหกรองขอมูลของพนักงานเพื่อแสดงรายชื่อพนักงานที่มีเงินเดือนอยูระหวาง 

30,000 – 40,000  มีข้ันตอนดังนี้ 

1) คลิกปุมคําสั่ง Filter จาก Ribbon Data 

2) คลิกปุม Filter ของฟลด Salary แลวเลือก Between… 

3) จะปรากฎไดอะล็อกบอกส Custom AutoFilter ข้ึนมาพรอมกับกําหนดเง่ือนไขไว

ใหอัตโนมัติ (เนื่องจากเลือกคําสั่ง Between ไว ถาเลือกแบบอ่ืน จะข้ึนลักษณะอ่ืน)   

2 
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4) ใหกรอกตัวเลขเพ่ิมลงไปตามภาพ คือชองแรก ใสเลข 30000 ชองท่ี 2 ใสเลข 

40000 เสร็จแลวกดปุม OK 

5) จะไดผลลัพธดังภาพ 

 
 

 
รูปที่ 3.38 แสดงวิธีการกรองจากรูปแบบ   

 
รูปท่ี 3.39 แสดงผลลัพธจากการกรองแบบกําหนดเอง 

 

2 

3 
4 
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3.3  การเรียงขอมูล Sort Data 

คุณสามารถเรียงลําดับคาในหนึ่งหรือหลายฟลด (คอลัมน) ในแผนงานหรือในตารางท้ังแบบ

เรียงจากนอยไปหามาก (Sort Ascending) หรือเรียงจากมากไปหานอย (Sort Descending) แตถามี

การเรียงทีละหลายฟลด จะตองระบุลงไปในกลองโตตอบดวย วาชื่อฟลดท่ีตองการเรียง ชื่ออะไรบาง  

ซ่ึงสวนใหญ Excel จะเขาใจวา แถวแรกของตารางคือชื่อฟลดเสมอ  ดังนั้นถาตารางท่ีจะเรียงไมมีหัว

ตารางจะตองระบุชื่อคอลัมนเอง  และใน Excel 2010 นี้ยังมีความสามารถเพ่ิมเติมคือ สามารถ

เรียงลําดับตาม สีของเซลล  สีของตัวอักษร และไอคอนของเซลลไดดวย   หรือจะระบุเพ่ิมเติมไดอีกวา

รายการท่ีข้ึนตนดวยอักษรตัวพิมพใหญและตัวพิมพเล็ก ควรจะแยกตางหากและการวางแนวของการ

จัดเรียง (วาคุณตองการ คอลัมนหรือแถวเรียง) จากปุม Option ในกลองโตตอบ Sort 

ตองการเรียงลําดับแผนงานหรือตารางเพียงหนึ่งฟลด  

เปนการเรียงลําดับขอมูลแบบธรรมดาคือมีการจัดเรียงเพียงฟลดเดียวมี 2 วิธีดังนี้ 

1) คลิกท่ีเซลลใด ๆ ในคอลัมน จากนั้นบนแท็บ Home ในกลุมคําสั่ง Sort & Filter 

ใหคลิกเลือกคําสั่ง Sort Smallest to Largest  หรือ Sort Largest to Smallest 

หรือ Custom Sort…  ตามตองการ  มีขอสังเกตวาคําสั่งการเรียงลําดับนี้จะ

แตกตางกันไปข้ึนอยูกับรูปแบบขอมูลในเซลล  

      
2) คลิกท่ีเซลลใด ๆ ในคอลัมน จากนั้นบนแท็บ Data ในกลุมคําสั่ง Sort & Filter ให

คลิก เรียง A To Z หรือ Z To A  

ตองการเรียงลําดับแผนงานหรือตารางมากกวาหนึ่งฟลด  

เปนการเรียงลําดับขอมูลแบบมีเง่ือนไขซ่ึงจะสามารถจัดเรียงไดครั้งละหลาย ๆ ฟลด  เหมาะ

สําหรับขอมูลท่ีมีลักษณะ ขอมูลในแตละฟลดซํ้ากัน  ซ่ึงการเรียงแบบนี้จะเทากับเปนการจัดกลุมขอมูลท่ี

ซํ้ากัน ทําใหขอมูลท่ีเหมือนกันจะมาอยูรวมกันใกล ๆ  

ตัวอยาง: จาก List รายชื่อพนักงานบริษัทสยามการคา จํากัด  จงเรียงลําดับขอมูลพนักงาน

ใหม โดยใหแยกตามแผนกท่ีพนักงานสังกัด และในแตละแผนก ใหเรียงตามตําแหนง และในกรณีท่ีอยู

ตําแหนงเดียวกัน ใหเรียงตามเงินเดือนโดยใหคนท่ีมีเงินเดือนสูงกวาข้ึนมากอน  มีวิธีการดังนี้ 

1) คลิกเมาสท่ีลิสต แลวเลือกปุมคําสั่ง Sort จาก Ribbon Data 
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2) จะปรากฎกลองโตตอบ Sort ดังรูปท่ี 2-2-36 ซ่ึงแตละปุมใชทํางานดังตอไปนี้ 

a. เพ่ิมเง่ือนไขในการจัดเรียง 

b. ลบเง่ือนไขในการจัดเรียง 

c. คัดลอกเง่ือนไข 

d. เปลี่ยนลําดับเง่ือนไข 

e. ตั้งขอกําหนดเพ่ิมเติม 

f. ระบุวาตารางมีแถวท่ีเปนชื่อฟลดหรือไม 

g. ตารางแสดงเง่ือนไขท้ังหมด 

 

 
รูปที่ 3.40 แสดงกลองโตตอบ Sort  

3) จากตัวอยางโจทย เง่ือนไขแรก  คอลัมน Column ใหคลิกท่ี Sort by  เลือก 

Departmentคอลัมน Sort On คลิกเลือก Value และ คอลัมน Order เลือกแบบ 

A to Z 

   

รูปที่ 3.41 แสดงวิธีการเลือกในกลองโตตอบ Sort  

4) กดปุม Add Level  เพ่ือเพ่ิมเง่ือนไขท่ี 2  คอลัมน Columne ใหคลิกท่ี Sort by 

เลือก Position แลวคอลมน Sort On คลิกเลือก Value และคอลัมน Order เลือก 

A-Z 

2)a 2)b 2)c 2)d 2)e 2)f 

2)g 
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5) กดปุม Add Level  เพ่ือเพ่ิมเง่ือนไขท่ี 3  คอลัมน Columne ใหคลิกท่ี Sort by 

เลือก Salary แลวคอลมน Sort On คลิกเลือก Value และคอลัมน Order เลือก 

Largest to Smallest ดังภาพตัวอยาง  เสร็จแลวกดปุม OK  

 
รูปที่ 3.42 แสดงวิธีการเลือกในกลองโตตอบ Sort ครบ 3 เงื่อนไข 

จะปรากฎผลลัพธดังนี้ 

 
รูปที่ 3.43 แสดงตัวอยางขอมูลที่เรียงเสร็จแลว   

3.4  การหาผลรวมสรุปยอยของขอมูล (Subtotal) 

การหาผลรวมยอย (Subtotal) เปนวิธีแบงขอมูลออกเปนกลุมยอย ๆ พรอมท้ังสรุปผลเชน 

เงินเดือนแยกตามแผนก จะใชวิธีแสดงขอมูลแบบเคาโครง (Outline) ซ่ึงจะสามารยอหรือขยายกลุม

ขอมูล ชวยใหเราสามารถดูเฉพาะภาพรวม หรือดูรายละเอียดในกลุมท่ีสนใจไดงาย 

1) ใหทําการจัดเรียงเรคคอรดตามฟลลชื่อแผนก (Department) กอน 

1) เลือกคําสั่ง Subtotal จาก Ribbon Data กลุมคําสั่ง Outline 
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2) เลือกฟลลท่ีจัดเรียงไวจากชอง At each change in 

3) เลือกฟงกชั่นสําหรับคํานวณผลสรุปจากชอง Used Function 

4) เลือกฟลลท่ีจะใหโปรแกรมคํานวณผลสรุปจากชอง Add Subtotal to 

5) คลิกเลือก Replace current subtotals เสร็จแลวกดปุม Ok ก็จะไดผลลัพธดังภาพ

ดานลาง 

 

  

 
รูปที่ 3.44 แสดงตัวอยางการใชคําสั่ง Subtotal 
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3.5  การตั้งกฎเพ่ือตรวจสอบขอมูลกอนกรอกลงฐานขอมูล (Validation Rule) 

เปนการตั้งกฎข้ึนมาเพ่ือใชในการตรวจสอบความถูกตองของขอมูล เวลากรอกขอมูลลงไปใน

ตาราง  ถาตองกรอกขอมูลเปนจํานวนมาก อาจทําใหเกิดขอผิดพลาดไดในขณะพิมพ ดังนั้นจึงจําเปน

จะตองสรางกฎข้ึนมาวา ในการกรอกขอมูล ณ ตําแหนงนั้น เซลล นั้น หรือคอลัมนนั้น  จะสามารถใส

ขอมูลอะไรไดบาง เชน ถาเปนการกรอกคะแนน ซ่ึงคะแนนเต็มคือ 25 คะแนน ก็ตองตั้งกฎไววาใน

คอลัมนนี้ใสเปนตัวเลขไดตั้งแต 0 -25 เทานั้น หามใสขอมูลอ่ืน ถามีการใสขอมูลท่ีไมเปนไปตามกฎ 

Excel จะแสดง Error message ข้ึนมาทันที เปนตน สําหรับในหัวขอนี้จะกลาวถึงการตั้งกฎไว 2 

ลักษณะคือ การตั้งกฎสําหรับตรวจสอบขอมูลท่ีเปนตัวเลข และการต้ังกฎสําหรับตรวจสอบขอมูลท่ี

เปนขอความ 

การตั้งกฎสําหรับตรวจสอบขอมูลที่เปนตัวเลข  

กฎนี้ใชกับขอมูลตัวเลขท่ีตองการกรอกลงไปในเซลล ยกตัวอยาง ตองการกรอกคะแนนสอบ

กลางภาคของนักศึกษาลงไปในคอลัมน G ซ่ึงเปนคอลัมนท่ีใชเก็บคะแนนกลางภาค กรอกตัวเลขได

ตั้งแต 0 – 25  (ไมมีการใหคะแนนติดลบ) และตองการให Excel ตรวจสอบตัวเลขท่ีกรอกลงไปดวย

วาเปนไปตามกฎหรือไม มีวิธีการดังนี้ 

(1) ดรากเมาสเลือกบริเวณท่ีตองการใหตรวจสอบขอมูลกอนกรอกลงไป ในท่ีนี้คือคอลัมน C 

(เลือกเฉพาะบริเวณท่ีจะกรอกคะแนน) 

(2) เลือกคําสั่ง Data Validation จาก Ribbon Data กลุมคําสั่ง Data Tools จะปรากฏไดอะล็อก 

บ็อกซตามภาพ 

(3) ในไดอะล็อกบ็อกซนี้จะมีแท็บหัวเรื่องอยู 3 เรื่องคือ Setting, Input Message, และ Error 

Alert  ใหคลิกเลือก Setting  ในชอง Allow : เลือก Whole number 

 
รูปที่ 3.45 แสดงการตั้งกฎสําหรับตรวจสอบขอมูล 
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รูปที่ 3.46 แสดงตวัอยางการตั้งคา และกําหนดเงื่อนไขในการรับขอมูล   

(4) ในชอง Data : จะมีคําสั่งเปรียบใหเลือกอีกเปนจํานวนมาก ในท่ีนี้ใหเลือก Between 

(5) ชอง Minimum:  ใส 0 (เลขท่ีนอยท่ีสุด)  และชอง Maximum : ใสเลข 25 (คะแนน

เต็ม) 

(6) คลิกเลือกแท็บ  Input Message เพ่ือใสขอความบงบอกวาเซลลบริเวณนี้ตองกรอก

ขอมูลอะไร (ไมจําเปนตองใสก็ได  เนื่องจากเกะกะเวลากรอกขอมูลจริง) โดย ให Check box (ใส

เครื่องหมายถูก) หนาคําสั่ง Show input message when cell is selected  แลวกรอกคําวา “การ

กรอกคะแนนกลางภาค” ลงไปในชอง Title: และใสคําวา “ใสตัวเลข 0 – 25 ” ลงในชอง Input 

message :  

 
รูปที่ 3.47 แสดงตวัอยางการใชคําสั่ง ตั้งขอความที่แสดงทางหนาตางโตตอบ 

 

0 

25 
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ภาพตัวอยาง เม่ือกําหนดหัวขอนี้แลว พอนําเมาสไปคลิกเลือกเซลลท่ีตั้งกฎไว จะปรากฏ

ผลลัพธตามรูป 

 
รูปที่ 3.48 แสดงผลลัพธของการใส Input Message 

(7) คลิกเลือกแท็บ Error Alert เพ่ือใหเกิด ขอความเตือนเม่ือมีการกรอกขอมูลท่ีไมถูกตอง

ตามกฎลงไป โดย ให Check box (ใสเครื่องหมายถูก) หนาคําสั่ง Show error alert after invalid 

data is entered   

(8) กําหนดประเภทของขอความเตือน หรือ Error Alert วาตองการใหเปนลักษณะใด มีให

เลือกดวยกัน 3 ประเภทซ่ึงจะใหผลลัพธแตกตางกันออกไป (ดูในตาราง)  สวนในชอง Title : ใหใส

ชื่อเรื่องท่ีตองการเตือนลงไปในท่ีใหใสคําวา “การกรอกคะแนน” สวนในชอง Error Message : ให

ใสขอความท่ีตองการอธิบายวาทําไมถึงเกิดขอความเตือนหรือใหคําแนะนําวาควรใสขอมูลอะไรลงไป

ในเซลล ในท่ีนี้ใหใสคําวา “ใสตัวเลขไดเฉพาะ 0 – 25 เทานั้น” เสร็จแลวกดปุม OK 

 
รูปที่ 3.49 แสดงการกําหนดหนาตางโตตอบเมื่อมีการกรอกขอมูลผิด   

ประเภทของขอความเตือน หรือ Error Alert ไดหลากหลายรูปแบบ  

- Stop เปนรูปแบบท่ีใชสําหรับหามไมใหใสขอมูลใดๆ ท่ีผิดกฎโดยเด็ดขาด 

จะตองใสตามกฎท่ีตั้งไวเทานั้น 
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- Warning เปนรูปแบบท่ีใชสําหรับเตือนวาขอมูลท่ีใสนั้นเปนขอมูลท่ีผิดกฎท่ีตั้ง

ไว ใหทําการเปลี่ยนขอมูลใหถูกตอง แตก็ยังสามารถใสขอมูลผิดตอไปได ถากด

ปุม Yes เพ่ือยืนยันวาตองการจะใสขอมูลนั้นจริง ๆ 

- Information เปนรูปแบบท่ีใชสําหรับบอกขาวสารวา ขอมูลท่ีใสนั้นผิดกฎท่ีตั้ง

ไวเทานั้น แตยังคงสามารถปลอยใหขอมูลท่ีผิดนั้นใสลงไปในเซลลได และยังคง

ทํางานตอไปได  

การตั้งกฎสําหรับตรวจสอบขอมูลที่เปนขอความ 

กฎนี้ใชกับขอมูลท่ีเปนขอความท่ีตองการกรอกลงไปในเซลล ยกตัวอยาง ตองการกรอกชื่อ

สาขาวิชาของคณะบริหารธุรกิจลงไป ซ่ึงสาขาวิชาท่ีกรอกนี้จะมี 5 สาขาเทานั้น และไมตองการให

สะกดผิด หรือใสสาขาวิชาของคณะอ่ืนลงไป จึงตองตั้งกฎในการกรอกไววาใหเลือกจากรายการ

สาขาวิชาแทนท่ีจะพิมพลงไปเอง มีวิธีการดังนี้ 

(1) ดรากเมาสเลือกบริเวณท่ีตองการใหตรวจสอบขอมูลกอนกรอกลงไป ในท่ีนี้คือคอลัมน  

B (เลือกเฉพาะบริเวณท่ีจะกรอกสาขาวิชา) แลวเลือกคําสั่ง Data Validation…  จาก Ribbon Data 

(2) คลิกเลือกแท็บ Setting ในชอง Allow : เลือก List 

 

 
รูปที่ 3.50 แสดงตวัอยางการกรอกขอมูลที่เปนรายการขอมูล  

(3) ในชอง Source : ใหใสชุดขอมูลท่ีตองการจะใหเลือกโดยไมตองพิมพลงไปเอง เพ่ือ

ปองกันการพิมพผิด หรือกรอกขอมูลอ่ืนท่ีไมเหมาะสม ในท่ีนี้คือเลือกเซลล D4 ถึง D8 (และมีการ 

ล็อกเซลลไวดวย) เสร็จแลวกดปุม OK 

(4) กําหนด Input Message หรือ Error Alert ตามตองการ อาจใสหรือไมก็ได โดยได

อธิบายไวแลวขางตน  

(5) เม่ือตั้งกฎเสร็จแลว เวลากรอกขอมูลก็ไมตองพิมพลงไปเองตรง ๆ อีกตอไป แตจะ

ปรากฏ ปุมสามเหลี่ยมชี้ลงออกมา เม่ือคลิก ก็จะปรากฏ list หรือรายการใหเลือกวา ตองการจะใส

สาขาวิชาใดลงไป 

2 

3 
5 
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(6) ถาพยายามจะกรอกขอมูลอ่ืนท่ีไมขอมูลตามในรายการท่ีกําหนด จะปรากฏ Error วาไม

สามารถใสขอมูลอ่ืนไดนอกจากในรายการท่ีมีใหเลือกไวเทานั้น 

 

รูปที่ 3.51 แสดงตวัอยางการกรอกขอมูลที่เปนรายการขอมูล  

3.6  การลบขอมูลที่ซ้ํากันใน List (Remove duplicate) 

ในการกรอกขอมูลจํานวนมาก ยอมอาจมีการผิดพลาดไดงาย โดยเฉพาะขอผิดพลาด

เรื่องการกรอกขอมูลซํ้าซอน ซ่ึงจะมีผลเสียอยางยิ่ง เม่ือมีการนําขอมูลเหลานั้นไปสรุปผล  มันอาจทํา

ใหไดขอสรุปท่ีคลาดเคลื่อนไปจากความเปนจริง Excel จึงเตรียมคําสั่งสําหรับตรวจสอบขอผิดพลาดนี้

ไวให มีชื่อวา Remove Duplicate  ซ่ึงมีวิธีการดังนี้ 

 

 
รูปที่ 3.52 แสดงตัวอยางการลบขอมูลที่ซ้ํากันในตาราง   

(7) คลิกเมาสให Active Cell อยูภายใน list 

(8) คลิกเลือกคําสั่ง Remove Duplicate จาก Ribbon Data กลุมคําสั่ง Data Tools  

(9) จะปรากฏไดอะล็อกบอกส Remove Duplicate ข้ึนมา ใหทํากา Check box หนาชื่อฟลด

ท่ีตองการใหตรวจสอบวามีการคียซํ้ากัน จะใส  เพียงฟลดเดียว หรือหลายฟลดก็ได ในท่ีนี้  ทุก

ฟลด  ซ่ึงหมายความวา ตองการใหดูวามีเรคคอรดไหนบางท่ีมีขอมูลซํ้ากันทุกฟลด แสดงวากรอกขอมูลซํ้า

กันหมด (บางสถานการณ ตรวจสอบเพียงฟลดเดียวก็ทราบแลววามีการกรอกขอมูลซํ้า แตบางสถานการณ
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จําเปนตองตรวจมากกวาหนึ่งฟลด  หรือตรวจทุกฟลดเพ่ือหาวามีเรคคอรดไหนบางท่ีซํ้ากัน)  เสร็จแลวกด

ปุม OK   

(10) จะปรากฏไดอะล็อกบอกส Information ออกมาแจงใหทราบวาไดทําการลบไปก่ีเรคคอรด 

กด OK เพ่ือทํางานตอไป 

 

 
รูปที่ 3.53 แสดงจํานวนขอมูลซ้าํที่ถูกลบไป 3 เรคคอรด 

3.7  การแปลงชุดขอความใหเปนตารางขอมูล (Text to Column) 

ในบางสถานการณอาจจะตองมีการนําขอมูลมาจากแหลงอ่ืน ๆ เพ่ือนํามาใชเปนรายการ

ขอมูล ซ่ึงแหลงท่ีมาของขอมูลตาง ๆ อาจไมไดอยูในรูปแบบของตารางเสมอไป บางครั้งขอมูลท่ี

คัดลอกมา อาจเปนเพียงขอความ หรือตัวอักษร ท่ีวางเรียงตอกันไวเทานั้น  Excel จึงเตรียมคําสั่งท่ีใช

สําหรับแปลงขอมูลท่ีเปนขอความหรือตัวอักษรลักษณะนี้ใหกลายมาเปนตารางได แตก็ยังมีขอจํากัด

วา ขอความหรือตัวอักษรท่ีจะนํามาแปลงนั้นจะตองมีรูปแบบการจัดวางท่ีเหมือน ๆ กัน ท่ีสามารถบง

บอกไดวา จุดสิ้นสุดของขอความแตละคอลัมนอยูตรงไหน  เชนอาจมีการเวนวรรค ณ ตําแหนงท่ีเปน

คนละคอลัมน หรือใสเครื่องหมาย , (comma) หรือ – (dash) ค่ันระหวางคอลัมนไวเหมือน ๆ กัน

หมด ยกตัวอยาง ให ทดลองพิมพไวในคอลัมน A ดังภาพดานขางนี้ 

   
เสร็จแลวใหดําเนินการตามข้ันตอนตอไปนี้ 

(1) ดรากสเมาสเลือกขอมูลจากเซลล A1:A5 

(2) คลิกปุมคําสั่ง Text to Columns จาก Ribboon Data กลุมคําสั่ง Data Tools 
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(3) จะปรากฏไดอะล็อกบอกส  Convert  Text to Columns Wizard Step 1 of  3 ออกมา  

ใหเลือกประเภทของขอมูล ซ่ึง Excel จะเลือกไวใหแลว ใหกดปุม Next ไปข้ันตอไปไดเลย 

 
รูปที่ 3.54 แสดงข้ันตอนการกําหนดคา   

(4) ข้ันท่ี 2  Excel จะแบงขอมูลใหดู กดปุมม Next ไปข้ันตอไป 

 
รูปที่ 3.55 แสดงตวัอยางขอมูลหลังกําหนดการแสดงผล 

(5) ข้ันท่ี 3 คลิกเลือกรูปแบบของขอมูลท่ีทําการแปลงคาเสร็จแลววาจะใหออกมาเปนอะไรใน

กลุมคําสั่ง Column data format  ซ่ึงเลือกเปน General ไว   สวนในชอง Destination ใสชื่อเซลล

ปลายทางท่ีตองการใหขอมูลไปแสดง Excel ก็เลือกไวใหแลว กดปุม Finish ไดเลย  
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รูปที่ 3.56 แสดงตวัอยางการกําหนดรูปแบบของขอมูลหลังการแปลงขอมูล   

(6) จะไดผลลัพธตามภาพ 

 
รูปที่ 3.57 ผลลัพธหลังจากทําการแปลงขอมูล   

3.8  การนําฐานขอมูลอ่ืน ๆ มาใชใน Excel 

User สามารถเปดใชขอมูลจากฐานขอมูลท่ีถูกสรางข้ึนดวยโปรแกรมอ่ืนได ซ่ึงไฟลท่ีจะนํามา

เปดนี้มีความหลากหลายมากข้ึน และใชงายข้ึน จะขอยกตัวอยางการเปดไฟลฐานขอมูลจาก text file  

 
รูปที่ 3.58 ตัวอยางขอมูลจากไฟล employee.txt 

(1) คลิกเลือกเวิรกชีตใหม  แลวคลิกแท็บ Data   แลวเลือกวาตองการนําตารางขอมูลจาก

โปรแกรมใดมาใสไวใน Excel  ในท่ีนี้คลิกเลือก From Text 
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รูปที่ 3.59 แสดงคําสั่งที่ใชดึงขอมูลมาจากแหลงอ่ืนๆ   

(2) คลิกเลือกโฟลเดอรท่ีใชเก็บฐานขอมูล จากชอง Look in: แลวเลือกไฟลขอมูลท่ีตองการ  

จากตัวอยางทําการเลือกไฟล employee.txt จาก Desktop  จากนั้นกดปุม Import  

 
รูปที่ 3.60 แสดงตวัอยางการเลอืกไฟลขอมูล   

(3) สําหรับไฟลท่ีมีนามสกุล .txt การนําขอมูลมาใชงาน จะมีลักษณะคลายกับการแปลงชุด

ขอความใหเปนตารางขอมูล (ไดกลาวรายละเอียดไวท่ีหัวขอ 3.7 การแปลงชุดขอความใหเปนตารางขอมูล)  

กรณีท่ีชุดขอความมีสวนท่ีเปนหัวตารางใหคลิกเลือก My data has header. 

 
รูปที่ 3.61 แสดงตวัอยางการเลอืกไฟลขอมูล   

1 
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(4) จากไฟล employee.txt  ใชวิธีการแยกแตละฟลดขอมูลออกจากกันดวยเครื่องหมาย

คอมมา (comma)  กรณีท่ีเปนไฟลขอมูลอ่ืน ใหสังเกตท่ีตัวขอมูลวาตองการจะแยกกันดวยสัญลักษณ

แทป, เซมิโคลอน หรืออ่ืนๆ  

 

 
รูปที่ 3.62 แสดงตวัอยางการกําหนดคาการนาํเขาขอมูล  

(5) กําหนดจุดท่ีจะวางตาราง จากตัวอยางจะวางขอความไวท่ีเซล A1  
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รูปที่ 3.63 การเลือกตําแหนงการวางขอมูล 

(6) เม่ือเปดไฟลข้ึนมาแลว จะไดผลลัพธดังนี้ 

 
รูปที่ 3.64 ผลลัพธจากการนําเขาขอมูล employee.txt 

3.9  การสรางรายงานสรุป และการวเิคราะหขอมูลดวย PIVOTTABLE 

หลังจากไดจัดทําตารางฐานขอมูลแลวสวนใหญจะไดตารางท่ีอาจมีความซํ้าซอนเนื่องจากใน 

Microsoft Excel ตองเก็บขอมูลทุกอยางไวในตารางเพียงตารางเดียว ไมมีการแยกตารางหรือนํา

ตารางไป Normalize เพ่ือใหไดหลาย ๆตาราง โดยท่ีแตละตารางอาจจะตองไมซํ้าซอนกัน อีกท้ัง 

Microsoft Excel ไมมีการสรางความสัมพันธระหวางตาราง ดังนั้น เม่ือทําตารางเก็บขอมูลเสร็จอาจ

ทําใหเกิดความสับสนและดูขอมูลในตารางยาก หรือสรุปขอมูลยากเนื่องจากขอมูลซํ้าซอน หรือ

คลายกันไปหมด ใหลองพิจารณาตารางเก็บขอมูล 

 
รูปที่ 3.65 แสดงตัวอยางขอมูลกอนนํามาสรางรายงานสรุป   
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ดังนั้นเม่ือถึงเวลาท่ีตองจัดทํารายงาน Microsoft Excel จึงเตรียมคําสั่งและระบบการจัดทํา

รายงานอัตโนมัติ หรือท่ีเรียกวา Pivot table ไวให User นําไปใชงาย ๆ และสะดวกรวดเร็วและยัง

สามารถแกไขรายงานไดงายและรวดเร็วอีกดวย ข้ันตอนการจัดทํา Pivot table มีดังนี้ 

 
1) ดรากสเมาสให Active Cell อยูภายใน List   

2) คลิกปุมคําสั่ง pivot table จาก ribbon insert กลุมคําสั่ง table 

3) จะปรากฎไดอะล็อกบอกส create pivot table ข้ึนมาเพ่ือกําหนดสิ่งตาง ๆ ดังนี้ 

- Choose the data that you want to analyze: เลือกขอมูลท่ีจะนํามามี

เคราะหในท่ีนี้ดูในชอง Select a table or range:ใหคลิกเลือกกลุมขอมูล

ท่ีจะนํามาทําเปน Pivot table ซ่ึง Excelจะเลือกไวแลวอัตโนมัติ 

- Choose where you want the table report to be placed:  ใหคลิ ก

เลือกวาจะแสดงผลลัพธท่ีไหน ระหวาง New Worksheet หรือวางไวใน 

Existing Worksheet ในท่ีนี้เลือก Sheet ใหม เสร็จแลวกด OK 

 
รูปที่ 3.66 แสดงหนาจอ Create PivotTable   

จะไดตารางผลลัพธดังภาพ ซ่ึงเปนตารางเปลาไวสําหรับให User เลือกแสดงผลตามท่ี

ตองการ 
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รูปที่ 3.67 แสดงหนาจอหลังจากใชคําสั่ง Create PivotTable โดยใหทําการลาก Fields จากเคร่ืองมือ

ทางขวา(Choose Fields to add report)  ไปวางในตําแหนงท่ีเปนสีเทา 

4) นําฟลดไปใสในตาราง โดยคลิกชื่อฟลดท่ีอยูทางขวาคางไวแลวลากไปใสตามจุดตางๆใน

ตาราง 

5) นําฟลดไปใสในตารางครบแลว จะไดผลลัพธตามตารางดังรูป ลองเปรียบเทียบกับขอมูล

ในครั้งแรกกอนทํา pivot table นี้  จะเห็นวาสามารถดูขอมูลไดงายข้ึน คัดแยกขอมูลได

ชัดเจนกวา ทนอกจากนี้ยังสามารถปรับแตงการแสดงผลตามความตองการไดตลอดอีก

ดวย 

- จากตัวอยาง ตองการเรียกดูขอมูลรายไดสําหรับแตละภาค และแตละ

หมวดหมู 1)ลากฟลดขอมูลภาคจาก PivotTable Fields ลงไปไวท่ีเมนู 

ROWS (กรณีตองการแสดงผลภาคในแนวแถว)  2)ลากฟลดขอมูลหมวดหมู

สินคาจาก PivotTable Fields ลงไปไวท่ีเมนู COLUMNS (กรณีตองการ

แสดงผลหมวดหมูในแนวคอลัมน) 3)ลากฟลดรายไดจาก PivotTable 

Fields ลงไปไวท่ีเมนู VALUES เพ่ือแสดงผลตัวเลขของรายได  

 
รูปที่ 3.68 แสดงหนาจอหลักจากใชคําสั่ง PivotTable เสร็จสมบูรณ 

ภาค 
หมวด 
รายได 
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 4. การสราง Dashboard   

  

 

 

รูปที่ 3.69 แสดงหนาจอผลลัพธ 

 

 

 

 

 

 

 

 

 

 

 

4.3 4.4 4.8 4.5 

4.6 4.7 
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4.1 การกําหนดขอมูลพ้ืนฐาน  

(1) สราง Sheet ใหม ตั้งชื่อวา Dashboard1 

(2) เอา Gridline ออก ใหไปท่ี View >  

(3) ตั้งคาหนากระดาษ Page Layout > Margins > Custom Margins > ใส 0 

ท้ังหมด และเลือกเพ่ือใหขอมูลอยูก่ึงกลาง  

 
รูปที่ 3.70 แสดงหนาจอ Page Setup 

 

(4) เลือกตั้งคาหนากระดาษเปนแนวนอน Page Layout > Orientation 

(5) ขนาดกระดาษ Size > A3 
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4.2 การกําหนดรูปแบบส ี

(1) https://htmlcolorcodes.com/ คลิกเลือก Picker 

 
รูปที่ 3.71 https://htmlcolorcodes.com 

 

(2) เลือกเฉดสีท่ีตองการ 

 
รูปที่ 3.72 หนาเพจสาํหรับเลือกเฉดส ี

(3) คลิกเลือก natural /ตัดเปนรูปภาพนําไปวางบน Excel > แลวกําหนด Theme สีตาม 

Code สีท่ีไดมา 

 
รูปที่ 3.73 Crop เพื่อเลือกเฉดส ี
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4.3 การทําสรุปยอดขายรายป Pivot Table แสดงอัตราการเติบโตเปน % 

ผลลัพธท่ีตองการ 

 
รูปที่ 3.74 ผลลัพธการทาํสรุปยอดขายรายปและแสดงอัตราการเติบโตเปน % 

 

 (1) คลิกท่ีมุม Sheet Law Data เพ่ือเลือกขอมูลท้ังหมด 

 
รูปที่ 3.75 Raw Data 

(2) ไปท่ี Insert > Pivot Table > เลือก new Worksheet 

 
รูปที่ 3.76 หนาจอ Create PrivotTable 
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(3) ตั้งชื่อ Pivot Table วา  พรอมตั้งชื่อชีท saleSum 

(4) Search คอลัมน Sale, Quantity, CustomerName ลากไปใสชอง Values 

 - คลิกท่ี Count of Sales > Value Field Settings.. เปลีย่นเปน Sum of Sales 

  - คลิกท่ี Count of Quantity > Value Field Settings.. เปลี่ยนเปน Sum of Quantity 

 
รูปที่ 3.77 หนาจอกําหนด Value Field Setting 

(5) ลากคอลัมน year มาวางท่ีชอง Columns  

(6) ลาก Value จากชอง columns > ไปท่ีชอง Rows 

 
รูปที่ 3.78 หนาจอ PrivotTable Fields 
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(7) เลือก Column Labels แสดงขอมูล 2 ป 2018, 2019  

 
รูปที่ 3.79 หนาจอกําหนด Column Labels 

 

(8) คลิกขวาท่ี Grand Total > Remove Grand Total 

 
รูปที่ 3.80 หนาจอ Rempve Grand Total 

 

(9) ใสสูตร %Change [ =C5/B5-1] แสดงเปน % (Home > คลิกเลือกเครื่องหมาย %) 

 
รูปที่ 3.81 หนาจอใสสูตร %change 
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  (10) ท่ี Sheet Dashboard1 ใหใสสีพ้ืนหลัง  

 
รูปที่ 3.82 กําหนดสีพื้นหลัง 

 

(11) คลิกเลือก Row ท่ี 6-8 ให Merge  & Center ท้ัง 3 กลอง (Home > Merge & 

Center) 

(12) ชองเซลล ใหพิมพ = แลวเลือกชีท saleSum คลิกท่ี cell Value ของป 2019 

 
รูปที่ 3.83 เลือกขอมูลที่ตองการแสดง 

 

(13) custome ขอมูลใหแสดงหลักลาน 

 
รูปที่ 3.84 การแสดงผลขอมูล 

 

 เลือกท่ีเซลลขอมูลชองแรก เลือกตรง Home >   > Custom > ในชอง 

Type ใหใส #,#.##,,  คอมมาหลังสุด 1 ตัวคือหารหลักพัน / 2 ตัวคือหารหลักลาน ถา 3 ตัวคือหาร

หลักพันลาน 
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รูปที่ 3.85 การกําหนดรูปแบบขอมูล 

 

ขอมูลชองท่ี 2  > format number เปน #,###.##, (หารพัน) 

ชองท่ี 3 ไมไดกําหนด format  

 

(14) คา %change ใหนํามาวางท่ีแถว 11-13 (Merge & Center) 

 
รูปที่ 3.86 การแสดงผลขอมูล 

 



 

เอกสารประกอบการสอนรายวิชา 720401 เทคโนโลยสีารสนเทศเพ่ือธุรกิจ 133 

(15) ตองการใสสัญลักษณ ถามากกวา 0 ใหเปนลูกศรสีเขียว ...ใหเลือกชอง 20% > 

Condition Formatting > เลือก Icon set > แลวให Manage Rule > คลิกปุม edit rule > ตอง

เปลี่ยน Type เปน number 

คา value 0.01 คือ 1% ใหเปนสีเขียว 

 
รูปที่ 3.87 Edit Formatting Rule 

 

4.4 การแสดงขอมูลตาม Category (ทํา Contribution ตามยอดขาย) 

ผลลัพธท่ีตองการ 

 
รูปที่ 3.88 ผลลัพธการแสดงขอมูลตาม Category 
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(1) คลิกท่ีมุม Sheet Law Data เพ่ือเลือกขอมูลท้ังหมด 

 
รูปที่ 3.89 เลือกขอมูลทั้งหมด 

 

(2) ไปท่ี Insert > Pivot Table > เลือก new Worksheet 

 
รูปที่ 3.90 หนาจอ Create PivotTable 

 

(3) ตั้งชื่อ Pivot Table วา %Contribution by Cat พรอมตั้งชื่อชีท Category 

(4) Search  เพ่ือเลือกคอลัมน  

- คอลัมน category ลากไปใสชอง Rows  

- คอลัมน Sale-ยอดขาย ไปใสท่ี Values 

- คอลัมน Year ไปใส Filter – เพ่ือกรองขอมูลตามป ถาไมกรองตามปปจจุบัน จะเปน

คา Contribution สะสมแทน จะตองเลือกปเปน 2019 แลวกดปุม OK 
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รูปที่ 3.91 หนาจอ PivotTable Fields 

 

(5) คลิกขวาท่ี Count of Sale > Value Field Settings.. เปลี่ยนเปน Sum of Sale แลว

คํานวณเพ่ิมโดยคลิกท่ีแท็บ Show Vales as…เลือก %of column Total 

 
รูปที่ 3.92 หนาจอ Value Field Setting 

 
 

(6) ขอมูลท่ีไดจะแสดงคาเปน % 

 
รูปที่ 3.93 หนาจอแสดงผล 
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(7) ถาตองการแสดงผลเปน pie chart > Insert > เลือก Pie Chart 

 

 
รูปที่ 3.94 หนาจอแสดงผล Pie Chart 

 (8) ถาตองการแสดงเปน Doughnut  Chart 

 
รูปที่ 3.95 หนาจอแสดงผล Doughnut  Chart 

 

(9) ถาตองการวาด Doughnut Chart เอง เพ่ือแยก Category เปน 3 วง 

9.1 เปลี่ยนขอความท่ีเซลล B3 เปน %Contribution 

9.2 เพ่ือเซล C3 Remaining เพ่ือหา % ท่ีเหลือ  

9.3 ท่ีเซลล B4 ใสสูตร =1-B4 (เลข1 แทนคา 100) (แลวแปลงเปน % ท่ี Home > %) 

รูปที่ 3.96 หนาจอตั้งคา Pivot Table 
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(10) อยูท่ีชีท Category ถาตองการวาดกราฟโดนัทเอง ใหคลิกขางนอกพ้ืนท่ี pivot table 

แลวเลือกประเภทกราฟ Insert > Doughnut Chart (อยูใน Pie chart) ใหกําหนดขนาดท่ี format 

> สูง 5.84 cm (2.3”) และ กวาง 5.08 cm (2”) 

 
รูปที่ 3.97 หนาจอการกําหนดขนาด Doughnut Chart 

 
รูปที่ 3.98 ขนาด Doughnut Chart 

 

(11) design > Select Data (หรือคลิกขวาเลือก select Data) โดยให Add ขอมูล Series 

> เลือกเซลล A4 (Furniture) 

สวน Series Values ใหเลือกเซลล B4-C4 กด enter 

รูปที่ 3.99 Select Data Source 
 

 
รูปที่ 3.100 Edit Series 
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(12) ใหกด Add เพ่ือสราง Pie อีก 1 วง วงขางนอกเอาไวทําแกนของกราฟ (Add Series 

เปลา โดยไมมีขอมูล) 

 
รูปที่ 3.101 Select Data Source 

 
รูปที่ 3.102 Edit Series 

ใน Doughnut Chart ใหลบ =1=2 ออก เพราะไมตองการคําอธิบาย 
 

(13) ใหคลิกท่ีกรอบของกราฟ คลิกขวา Change Chart Type > Combo 

 
รูปที่ 3.103 Change Chart Type 
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(14) เลือก Custom Combination แลวเลือก Chart Type เปน Doughnut พรอมคลิก

เลือก Furniture เปน secondary (จะแสดงอยูขางบน) สวน Series2 จะเปนแกน (อยูขางลาง) แลว

กด OK 

 
รูปที่ 3.104 Change Chart Type 

 

จะได Doughnut Chart 2 วงทับกันพอดี 

(15) แตงขนาดกราฟโดยแตงแกนขางในกอน คลิกขวาท่ีวงตรงกราฟท่ีเราจะแตง  > Format 

Data Series > 

 
รูปที่ 3.105 Change Chart Type 
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(16) Doughnut hole size เลือกไว 65% จะไดวงดานใน 

 
รูปที่ 3.106 Doughnut hole size 

 

- คลิกเลือกท่ีวงดานใน เลือกเทสี  เลือกสีดํา , border เลือก no line 

 
รูปที่ 3.107 Format Data Point 

 

(17) กลับไปคลิกท่ีขนาดโดนัท กําหนดขนาด 85% ทําใหแกนสีดําไปอยูดานใน 

 
รูปที่ 3.108 Format Data Point 
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(18) ไปคลิกท่ีวงดานนอก กําหนดขนาด 75% -ขนาดจะใหญกวาแกนสีดํา และเลือกคลิก 

 เพ่ือเทสีของขอมูล (คลิกครั้งแรกตรงโดนัทเปนการเลือกท้ัง 2 สวน /ตองคลิกตรงสีเขียวอีกครั้ง 

เทสีท่ีตองการ และเลือก No line)  

 
รูปที่ 3.109 Format Data Point 

 

- วงสวนท่ีเหลือใหเลือก No fill และ No line 

 
รูปที่ 3.110 Format Data Point 

 

(19) หลังจากไดกราฟเรียบรอยแลว ให Copy อีก 2 อัน (Ctrl+C ,Ctrl+V) 

 
รูปที่ 3.111 Copy กราฟอีก 2 วง 

- ใหคลิกขวาท่ีกราฟท่ี 2 > Select Data…> คลิกท่ี Furniture กดปุม Edit เลือกเปน 

Office Suppliers 
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รูปที่ 3.112 Select Data Series 

 

 
รูปที่ 3.113 Edit Series 

 

- กราฟท่ี 3 > Select Data…> คลิกท่ี Furniture กดปุม Edit เลือกเปน Technology 

ผลท่ีได 

 
รูปที่ 3.114 ผลลัพธ 

 

(20) เม่ือทํา Doughnut Chart ท้ัง 3 วงเสร็จเรียบรอยแลว ใหกด Shift เพ่ือเลือกกราฟท้ัง 

3 วงไปวางท่ีหนา Dashboard1  
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(21) ถาตองการใหกราฟท้ัง 3 วง มีขอบบนท่ีตรงกัน > ใหเลือกกราฟท้ัง 3 รูป > Format > 

Align > Align Top หรือถาตองการกราฟท้ัง 3 มีระยะหางท่ีเทากัน > Format > Align 

>Distribute Horizontally 

 
รูปที่ 3.115 กําหนด Align 

 

(22) ถาตองการใหมีตัวเลขอยูดานในกราฟ Doughnut Chart > insert > TextBox วาดใน

กราฟ > ไปท่ี Formula Bar พิมพ = แลวเลือกชีท Category คลิกเลือกเซลล B4 (%Contribution

ของ furniture) [**ดูหมายเหตุ1] 

=Category!B4, =Ctegory!B5, =Category!B6 

**ใหปรับขนาดตัวอักษร และ Align ไดตามตองการ  

**copy TextBox จากรูปแรก วางดานนอกกราฟกอน แลวคอยยายไปวางในกราฟ 

**ให Group อ็อปเจ็กตท้ังหมดเขาไวดวยกัน โดยเลือกท้ังหมด Format > Group 

 
รูปที่ 3.116 กําหนดขอความในกราฟ 

 

หมายเหตุ1 - ถาเลือก cell แลว แสดงดังนี้

 
ใหเลือก File > Options > ใหเอา ออก Use GetPivotData functions for PivotTable 

references 
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รูปที่ 3.117 Excel Options 

 

(23) ทําเงาโดยคลิกท่ีกรอบสี่เหลี่ยม > Format Chart Area > Effects > Presets 

**ทําทีละรูป แตละรูป เลือก No fill และ No Line 

 
รูปที่ 3.118 Format Chart Area 

 

(24) สรางรูปสี่เหลี่ยมเพ่ือแสดง Category เลือก Insert > Shapes > เลือกรูปสี่เหลี่ยม 

 
รูปที่ 3.119 Insert Shapes 
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เลือกกลองสี่เหลี่ยม ใหพิมพท่ี Formula Bar = แลวคลิก ชีท Category เลือกเซลล A4 

 
รูปที่ 3.120 Insert Shapes 

 
ผลลัพธท่ีได 

 
รูปที่ 3.121 ผลลัพธที่ได 
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(25) การทํา %Growth by Category > ไปท่ีชีท Category > ให Copy ขอมูล A1:B7 วาง

ท่ี A15 เพ่ือหา %Growth 

 

 

 

- Analyze > ตั้งชื่อ Pivot Table : %Change by 

Cat 

- ยายคอลัมน year จาก Filter ไปเปน Columns 

 

จะใชขอมูลเปรียบเทียบกับปกอนหนา คือ 2018 

เปรียบเทียบกับ 2019 เลือกที่ Columns Labels 

 

-คลิกขวาที่ Grand Total > Remove Grand 

Total 

 

 

 

 

> Values> เปลี่ยน %Contribution คลิกเลือก 

Value Field Setting> Show Value As 

>%Difference From 

 

รูปที่ 3.122 %Growth by Category 
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ผลลัพธท่ีได จะได %growth by category 

 
รูปที่ 3.123 %Growth by Category 

(26) ไปท่ีชีท Dashboard1 -> เทสี และ Merge A15:C16, D15:F16, G15:I16 

 
รูปที่ 3.124 Merge Cell 

พิมพ =Category!C19, =Category!C20, =Category!C21 

- ใช Format Painter เพ่ือ Copy Pattern จากรูปแบบกอนหนา (เซลล M11) 

 
รูปที่ 3.125 แสดง %change 

 (27) แสดงยอดขาย ให copy ขอมูลชุดเดิม วางใหม 

 
กรองเฉพาะป 2019 

 
เลือกขอมูล 3 เซลล เพ่ือจัด Format พรอมกัน 

 
Values > Sale by Cat > Value Field Setting > 

number Format > Custom > #,##.##,, “ MB” 

หรือเลือกจาก list ท่ีเคยทําไว 

ยาย Columns : Category, Rows : Year 

 
%Contribution เปลี่ยน Sum of Sale 

Show Value As > No Calculation 

 
รูปที่ 3.126 แสดงยอดขาย 
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ผลลัพธท่ีได 

 
รูปที่ 3.127 แสดงยอดขาย 

 

(28) Insert > Pivot chart > Bar > 100% Stacked Bar 

 
 รูปที่ 3.128 Insert Chart 

 

- ให Hide All Field Button on Chart 

 
รูปที่ 3.129 Hide All Field Button on Chart 

 
 

 

 

ใหคลิกท่ีเครื่องหมาย + เพ่ือเอา 

Regend, Axis, Gridline ออก 

- เลือกเฉพาะ Data Labels 
 

รูปที่ 3.130 กําหนด Chart Elements 
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(29) ให copy กราฟไปไวหนา Dashboard1> ปรับขนาดของกราฟ ใหคลิกขวาตรงกราฟ > 

Format Data Series 

 

Set คา Gap Width 0% 

- คลิกขวา ปรับสีใหตรงกับกราฟโดนัท 

- เลือก No line 

รูปที่ 3.131 Format Data Series  
 

 

4.5 การแสดง Sale Trend By Category 

ผลลัพธท่ีตองการ 

 
รูปที่ 3.132 ผลลัพธ Sale Trend By Category 

 

(1) ไปท่ีชีท Category > Copy pivot Table ตารางยอดขายของปปจจุบัน (Sale by Cat)  

 
รูปที่ 3.133 Copy pivot Table 
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(2) คลิกท่ี  Row Labels > เลือกป 2 ปลาสุด 

 
รูปที่ 3.134 Copy pivot Table 

3. คลิกท่ีขอมูลในตาราง > Show Field List > ดึงคอลัมน Month (ชื่อเดือน มาใส Rows) 

 
รูปที่ 3.135 PivotTable Fields 

 

** ถา Month ไมเรียง ใหคลิกท่ีชื่อเดือนใดเดือนหนึ่ง > คลิกท่ี Row Labels > More Sort options 

 
รูปที่ 3.136 Sort Options 
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- เลือก Ascending > กด More Options 

 

เอา Sort Automatic ออก แลวเลือกรูปแบบ

การ Sort 

 

รูปที่ 3.137 Sort Options 
 

(4) Insert >  Pivot Chart **ตั้งชื่อ Sale Trend 

 
รูปที่ 3.138 PivotChart 

5. เลือก Column > Stacked Column 

 
รูปที่ 3.139 Insert Chart 
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6. คลิกขวาท่ีแทงกราฟ > Format Data Series > Gap Width >ปรับตัวเลขนอยลงกราฟจะใหญ

ข้ึน 

 
รูปที่ 3.140 Format Data Series 

 
 
7. คลิกขวา > Format Chart Area > เลือก No fill / No Line > เติม Shadow 

 
รูปที่ 3.141 ผลลัพธที่ได 
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4.6  การทํากราฟ Top 10 ของ Customer 

ผลลัพธท่ีตองการ 

 
รูปที่ 3.142 ผลลัพธ Top 10 Customers 

(1) ไปท่ี Raw Data คลุมขอมูล > Insert Pivot Table > ตั้งชื่อชีทและ Pivot Table วา  

top10 

- Rows : Customer Name 

- Values : ลาก Sale 3 ครั้ง 1) Sum of Sale  2) Contribution ของแตละคน ใช %of 

Column Total 3) เลือก CustomerName > %Running Total in (%Contribution สะสม) 

   

รูปที่ 3.143 Value Field Setting 

(2) เลือก Filter : Year 

 
รูปที่ 3.144 PivotTable Fields 
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- คา %contribution ใชวัดสัดสวนความสําคัญของขอมูลท่ีเราตองการเปรียบเทียบ เชน 

ลูกคาคนท่ี1 สัดสวนยอดขายคิดเปนก่ี % ของยอดรวมท้ังหมด 

- คา %contributionrunning เปนสัดสวนสะสม เชน ลกูคาคนท่ี 1 ถึงคนท่ี 10 มียอด

สะสมคิดเปนก่ี %ของยอดท้ังหมด 

 

(3) คลิกขวาชอง Sum> Sort >Largest to Small 

 
รูปที่ 3.145 Sort Data 

 
(4) ไปท่ีชีท Dashboard1 เลือก Row คลุมลงไป 10 Rows 

(Row 45-54) ขยาย Row เพ่ิมเล็กนอย 

 
รูปที่ 3.146 Select Rows 
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(5) ตีเสนตาราง Allborder > 1 ชอง, Merge 3 ชอง, Merge 2 ชอง, Merge 2 ชอง, 

Merge 2 ชอง >drage แถวแรก Format Painter > ลากคลุมชองตารางท่ีเหลือ 

 
รูปที่ 3.147 AllBorder 

 

(6) คอลัมนแรกใหใสเลข 1-10  

(7) คอลัมน 2 ใหพิมพ = แลวไปคลิกชื่อ CustomerName ท่ีชีท top10 เฉพาะคนแรก  

(8) กลับท่ี Dashboard1 ลากลงมาใหครบ 10 ชอง 

(9) ทําขอ 7-8 อีกครั้ง แตใหเลือกคา Sum /Distribution/และ Distribution สะสม 

(10) Custom ตัวเลขชอง Sum ใหเปนหลักลาน คลิกขวา Format Cell  

(11) ชอง Sum > Condition Formatting > Data Bar  

(12) ชอง %Contribution > Condition Formatting > Color Scale > เลือกแบบท่ีเปนสี

เดียว > Manage Rules > คลิกปุม Edit Rule 

 
รูปที่ 3.148 Edit Formatting Rule 
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(12) สรางหัว Dashboard โดย Insert Shape > เลือกรูปทรงท่ีตองการ 

 
รูปที่ 3.149 แทรก logo  

 

4.7 Cost & Profit 

(1) ไปท่ี Raw Data คลุมขอมูล > Insert Pivot Table > ตั้งชื่อชีทและ Pivot Table วา  

CostVsProfit 

 - Values: ใหดึง Cost กับ Profit เปลี่ยนเปน Sum of Cost, Sum of Profit 

 - Rows : Year 

 
รูปที่ 3.150 PivotTable Fields 

 

(2) ขอมูลใน Pivot table > Custom ใหเปนหลักลาน 

(3) เปลี่ยนชื่อท่ีหัวตารางจาก Sum of Cost -> Cost (ช่ือตรงกับช่ือคอลัมน ใหเคาะวรรค 

1 ครั้ง) และ profit 

(4) Insert > Pivot Chart > Bar > Stacked Bar 

 
รูปที่ 3.151 PivotChart Fields 
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รูปที่ 3.152 Chart Elements 

 

 
 

(5) Data Label  > Inside Base 

(6) คลิกขวาท่ีแทงกราฟ > Fill เลือกสี 

(7) กําหนดขนาดของกราฟ Format >สูง 8.19 cm และกวาง 10.33 cm 

(8) ให Copy ตาราง เพ่ือหาคา %GP (Gross Profit) 

 กําไรข้ันตน หรือ (GP) คือ ยอดขาย (Sales) ลบดวยตนทุนขาย (Cost of Goods Sold) เชน 

บริษัทคาปลีกหนึ่งซ้ือสินคามา 600,000 บาท ขายสินคาออกไปท้ังหมดไดยอดขาย 1,000,000 บาท 

แปลวาบริษัทมีกําไรข้ันตน 400,000 บาท 

 
รูปที่ 3.153 Chart แสดง GP 

 (9) ใหลบคอลัมน Cost และ Profit ออกไปกอน > เลือก Analyze > เลือก Fields, Items 

& Sets 

 
รูปที่ 3.154 Chart แสดง GP 
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(10) ใสสูตรสําหรับหาคา %GP 

 
รูปที่ 3.155 Chart แสดง GP 

 (11) Format ตัวเลขใหเปน % (Home > %) 

 
รูปที่ 3.156 Chart แสดง GP 

 

(12) Insert > Pivot Chart > Bar > CusteredBar 

 
รูปที่ 3.157 Insert Chart  
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(13) copy chart ท่ีไดไปไวใน Dashboard1 

 
รูปที่ 3.158 Insert Chart 

 

4.8 การทํา Slicer 

ผลลัพธท่ีตองการ 

 
รูปที่ 3.159 ผลลพัธการทํา Slicer 

 

(1) ไปท่ีชีท SaleSum > คลิกท่ีพ้ืนท่ี Pivot Table > Insert > Slicer > เลือก Month no 

และ Region 

 
รูปที่ 3.160 Insert Slicers 
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(2) ให Cut Slicer ท้ัง 2 ไปไวท่ีหนา dashboard1 

 
รูปที่ 3.161 Slicers 

(3) ท่ีหนา dashboard1 >Slicer Region ถาตองการเอา Blank ออก >Option> คลิกท่ี 

Slicer Setting 

 
รูปที่ 3.162 Slicer Setting 

(4) สําหรับ Slicer เดือน ใหปรับเปน 12 columns > แลวขยายขนาดออกไป  

 
รูปที่ 3.163 Slicer Options Setting 
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(5) ถาตองการใหคลิกท่ี Slicer แลวขอมูลเปลี่ยนทุก Chart > คลิกขวาท่ี Region >Report 

Connect จะมีชื่อ Pivot table ท้ังหมดปรากฎข้ึนมา 

 
รูปที่ 3.164 Slicer Options Setting 

 

(6) Region Link ทุกตาราง 

(7) Month ลิงคทุกตารางยกเวน Sale Trend 
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แบบฝกหัดบทที่ 3 

ใหนักศึกษาดาวนโหลดไฟล Assignment-Team.xlsx จาก Google Classroom เพ่ือนํามา

ทดลองใชโปรแกรมคําสั่งเพ่ือคนหาคําตอบใหไดตามท่ีโจทยกําหนด แลวเขียนอธิบายวิธีการทําทุกขอ 

ขอท่ี 1  จงกรองขอมูลใหแสดงเฉพาะพนักงานท่ีมีเงินเดือนอยูระหวาง 70,000-100,000 

ขอท่ี 2  จงกรองขอมูลใหแสดงเฉพาะ พนักงานท่ีมีตําแหนง Admin. Assist. และมีเงินเดือน

สูงกวา 25,000.- และเขาทํางานในป 1985-1987 

ขอท่ี 3 จงเรียงลําดับโดยมีเง่ือนไขดังนี้  

-  กอนเรียงตรวจดูวามีรายการซํ้ากันหรือไม ถามีรายการซํ้ากันใหลบรายการท่ีซํ้าออก  

-  อันดับแรกใหเรียงตามชื่อพนักงานขาย  เรียงตาม A-Z 

-  อันดับสอง ถาพนักงานขายแตละคนขายไดหลายรายการ ใหเรียงลําดับตามวันท่ีขาย 

-  อันดับสาม ถาวันท่ีขายซํ้ากัน ใหเรียงโดยนํารายการท่ีมีรายไดสูงข้ึนมากอน  

ขอท่ี 4  ใหหาผลรวมสรุปวา พนักงานแตละคนมียอดขาย (Sale Amt) รวมเปนจํานวนเงิน

เทาไหร และแตละคนขายของใหลูกคาไดก่ีราย  

ขอท่ี 5  ใหหาผลสรุปยอยของรายไดพนักงาน โดยแยกตามคา commission ท่ีจายใหกับ

พนักงาน  

ขอท่ี 6 จงกําหนด Validation Rule เพ่ือใหสามารถกรอกคะแนนไดไมเกินคะแนนเต็มท่ี

กําหนดไวบนหัวตาราง  

ขอท่ี 7 จงใชฟงกชั่น Vlookup คํานวณผลลัพธในเซลล C24-C44 เพ่ือให Excel แสดงชื่อ 

Product Name ท่ีถูกตองตรงกับ ProductID ท่ีปรากฎใน B24-B44  

ขอท่ี 8 ใหแสดงสถานะเงินเดือน (Salary) ของแตละคน วารายไดเปนอยางไรเม่ือเทียบกับ

พนักงานคนอ่ืน ๆ 

ขอท่ี 9  ให hightlight ยอดขาย (Sales Amt) เฉพาะท่ีมียอดขายต่ํากวา 10,000 ดวยการทํา

ตัวอักษรสีแดงเขม และตัวหนา 

ขอท่ี 10 ให hightlight พนักงาน ท่ีชื่อ O'Hara ดวยพ้ืนสีเขียวออน  

ขอท่ี 11 จงสรางรายงานสรุปอยางรวดเร็ว (PivotTable) โดยท่ี Page Field แยกตามภาค, 

Data Item แยกตาม รายได, Column Field แยกตามหมวด, Row Field แยกตามสาขา ซ่ึงรายงาน

สรุปนี้ ใหสรางเปนเวิรกชีกใหมและตั้งชื่อวา RE-PivotTable 

ขอท่ี 12 จงใสฟงกชั่นเพ่ือคํานวณหา เงินเดือนรวมของพนักงานท่ีทํางานในแผนก Art ใสลง

ไปในเซลล F 22    

ขอท่ี 13 จงใชขอมูลในตาราง A20:G134 ประกอบการหาผลลัพธ โดยใหใสฟงกชั่นเพ่ือ

คํานวณหา เงินเดือนสูงสุด เงินเดือนต่ําสุด เงินเดือนเฉลี่ย และจํานวนคน โดยแยกตามตําแหนงงานลง

ไปในตาราง ไปในเซลล B14:F15 
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